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MODEL

6000 CONTROL MENU

STRUCTURE

»1. interoctive Control...
2. Sequence File Control..
3. Immediate Operation...

—
CONTROL MENU — MAIN MENU

Interoctive Control

»1. Seal Cramber
2. Purge & Seal
3. Vel & Sedl
4. Pump_Continuous
5 Vent Continuous

Uove to index
e

Shutdawn Wode
Abort.

Fill Dewor...

Poused Sequence Control Now®: 1
bil_ ;:; . 01-»Temp 1250 200
. Subset...
3. Cont 02 <Endfie>
4. Pouse
5. AB0RT

CONTROL MENU — INTERACTIVE CONTROL MENU

Interoctive Move Positioner

Current Pasition: 0.000 Deg
= 0 steps

Use ALT, INCR, DECR keys

e o
INTERACTIVE CONTROL - MOVE... SUBWENU

Selective Abort Operotions

» 1. Temparature contrel only
2. Iloqnel control
3’ Position control only
4. Others: Drivers, Digital Lines

idges. Cramber Opy, Level i
0. Al Systems (seme o3 [ABOAT))

INTERACTIVE CONTROL - FILL DEWAR... SUBWENU

Hefum Level
Present leve: 60X  Sersor On

Fl Rate : 0 X / Winute

Exit ot: 19:35 [INCR/DECR]

INTERACTWE CONTROL — FILL DEWAR.. SUBWENU

CONTROL MENU - SEQUENCE L‘IWWDL MENU

Segment

Start of: #1
End ot : 1

[EXEC]=Run

Run 01->Temp 1250 200
Sequence 02 <Endfie>

I | EoFo

SEQUENCE CONTROL -

SUBSET... SUBMENU

Set System Temperoture
Temperoture: » 270.0 K
Rote H 10.1 K/m
Approoch : Mo Overshost
(Now ot: 270.0 STASLE)

[EXEC) to Execute (

b e e S
MMEDATE OPERATIONS — TEMP SUBMENU

Set Mognetic Fiekt

Vo i p Oe
Rots  : 0 Oe/fsec
Approach: Oscillate

Mode  : Persist Magnet

(Stotus: PERSIST Q)
[EXEC] to Execute ( )

e
IMMEDIATE OPERATIONS — FIELD SUBMENU

Uove Positioner

0.000
15.0 Deg/sec
: Normol
Reduction Foctor: 00
(Now ot : 0.00 Deg)
[EXEC] to Execute { )

INMEDATE OPERATIONS - MOVE SUBMENU

¥ Select Configuration: 1

I
¥,
e

Vent' Continuous
[EXEC] to Execute 4

Configure Somple Chamber

IWVEDATE OPERATIONS - CHAMBER SUBMENU



Comment

Immediote Operations___________
06: Bridge 11: Meosure
07: DigSet 12: Link
08: OrvOut 13:  MagRst
03° ExtSet
10:  SigOut
[ ] Select

CONTROL MENU — IMMEDATE OPERATIONS MENU

Put Comment in Doto File

[EXEC] to Execute ( )

=
IMVEDATE CPERATIONS — COMMENT SUBMENU

Setup Bridge Channel

Cafibration Mode: Standord
[EXEC] to Execute ( )
-
IVMEDIATE OPERATIONS - BRIDGE SUBMENU
Set Digital OQutputs
Aux. Drive §1 : » Off
Aux. Drive §2 @ Off
Aux. Drive §3 :  Off
Actugtor Drive :  Off
[EXEC] to Execute ( )
IMMEDIATE CPERATIONS — DIGSET SUBMENU
Set Driver Outputs
Chan el
Current 0.0 mA
Power Limit 0.0 mw
[EXEC] to Execute ( )

IMMEDIATE D?ERAHONE — DRVOUT SUBMENU

Set Externol Select Lines
Select  §1:» Off
Select 2 off
Select  §3: Off

[EXEC] to Execute ( )

e
IMMEDIATE OPERATIONS — EXTSET SUBMENU

Set Voltage Ouput
at BNC Connector

Channel : » 1

Voltage : 0.0
[EXEC] to Execute ( )
IMMEDATE OPERATIONS — SIGOUT SUBMENU
Dota File Meosurements  x0007
»#Status BrglRes Brg3Res Sig1
*Temp BrgiExc Brg3Exc Sig2
«Field BrgZRes Brg4Res Digln
Pos Brg2Exc Brg4Exc More...
[EXEC] to Execute ( ) #-> Selecled

IMUEDIATE OPERATIONS — MEASURE SUBMENU

Link BNC to Parameter
Output Channel >
Link to Porometer §:  —off—
Value ot +10 V : 0
Value ot O V : 0
[EXEC] to Execute ( )

IMMEDIATE OPERATIONS - LINK SUBMENU

Vagnet Quench

(Status: Persist 00.0

[EXEC] to Execute (

Drive to Field: O
Rate 1 Oefsec

)

)

IMMEDIATE OPERATIONS — QUENCH SUBMENU




MODEL 6000 CONFIG MENU STRUCTURE

CONFIGURE

sl
2. Serial Port...
3. IEEE-488 Porl...
4. Level Sensor
5. Software
6. Hardware

CONFIGURE MENU — MAIN MENU

Serial Port Setup Level Sensor
__________ Monitor Hourly :»Yes
Egﬁ:,:f:: ¢ Current Level : 30%
SRQ Char 2 Preheal Time : 10 sec
Termination String: LF/CR (voltoge ct 0% = 18.6 V)

[EXEC] to Execute ( ) [£XEC) to Execute
—_—
CONFIGURE MENU - SERIAL PORT MENU CONFIGURE MENU - LEVEL SENSOR MENU

Time & Date
HH:MM:SS  »12: 34: [56]
MM-DD-YY 02 — 09 - 94

IEEE—4B8 Setup

Send EOS No
EOS Volue 10
QUTPUT BUFFER MODE: Append
Ignore REM line: Yes
[EXEC] to Execute ( )

CONFIGURE WENU — IEEE- 488 PORT MENU

CONFIGURE MENU - TIME & DATE WENU
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Software

User Preferences...

. Error Logging...
. Diognostics.
. Data Display...

v

o sl

Hardware

Magnet Configuration...
Magnet Reset Configuration...
Posilion Configuration...

. Pressure Sensor...

CONFIGURE MENU — SOFTWARE MENU

User Preferences

Enable Sounds: M On

Display Input Signals: None

[EXEC] te Execute

SOFTWARE - USER PREFERENCES SUBMENU

Error Loggng

(Source) Sound RS2¥2 DatoFile
Command: On On On
Magnet Oon On On
Temp H Cn On On
Misc : On On On

EXEC] to Execule

SOFTWARE - ERROR LOGGING SUBMENU

Diagnostic Settings
1. System Diognosis: » Discble

2. Bridge Display chon : Standord
3. Factory Defaults on Pwr up: No

[EXEC] to Execute ( )

SOFTWARE - DIAGNOSTIC FLAGS SUBMENU

Data file Viewer Configuration

Time display: » Relative
Time Scale: Seconds

[EXEC] to Execute ( )

SOFTWARE - DIAGNOSTIC FLAGS SUBMENU

CONFIGURE MENU

— HARDWARE MENU

Magnet Configuration

Maximum Field 10000 Oe
B/1 Ratio g 200 Oe/Amp
Magnet Inductonce : 200 x Henrys

Charging Voltage LoB: 1.0 HiB: 1.0
Persist Swt time Wrm: 10 Cool: 15

[EXEC] to Execute [§ )

HARDWARE — MAGNET CALIBRATION SUBMENU

Magnet Reset Configuration

Moximum Initiol Field:» 1000.00

Reset Heat time: 10 seconds

Reset Cool time: 60 seconds
[EXEC] to Execute ( )

HAROWARE — MAGNET RESET CONFIGURATION SUBMENU

Position Configuration

Units : » De
Units/Step: 1.0
ange : 360.00

Enable Index SWitch: No

[EXEC] to Execute
HARDWARE — POSITION CONFIGURATION SUBMENU

Pressure Sensor

Sensor  :» Barotron
Units i _User
Units/V Table

[EXEC] to Execute

HARDWARE — PRESSURE SENSOR SUBMENU







Abort

Introduction The Abort command is used to terminate execution of a sequence file or system operations. Selected
systems may be aborted from the Model 6000 controller Selective Abort Operations screen or all PPMS
control systems may be aborted by using the front panel Abort key.

Model 6000 Press the following keys to view the Model 6000 Selective Abort Operations screen:

Keystrokes
Control, Interactive Control, Abort

Screen The Model 6000 Selective Abort Operations screen is shown below:

Description

Selective Abort Operations

» 1. Temperature Control only
2. Magnet Control only
3. Position Control only
4. Others: Drivers, Digital Lines,
Bridges, Chamber Ops, Level Mtr . . .
5. All Systems (same as [ABORT])

Selection The following table describes the selection items of the Selective Abort Operations screen:
Items
Select... In Order To Abort ...
1. Temperature Control Only | all temperature control operations.
2. Magnet Control Only all magnet control operations.
3. Position Control Only all position control operations.
4. Others: Drivers, Digital systems not listed above.
Lines . . .
5. All Systems (same as all PPMS control systems. This has the same effect as
[ABORT]) pressing the front panel ABORT key (ALT and +/-).
To Abort The following instructions explain how to abort a PPMS control system:
Control
Operation 1. Enter the Selective Abort Operations screen.

2.

3.

NOTE:

Place the cursor at the selected menu item.

WARNING:  When an ABORT command is entered, the aborted sub-system will be aborted

immediately.

Press the ENTER key to abort operation of the selected system.

To terminate sequence file execution, use the Abort command found on the Sequence Control

screen (CTRL,2). (See Sequence Files).

Abort



Alternative To abort all system operations, rather than select item 5. All Systems, the ABORT key on the Model 6000
Abort Method front panel may be used:

Press ALT and +/- to abort all PPMS control system.
To Resume To re-enable the system following an ABORT command, enter a command that requires the aborted system.
Operation If All Systems were aborted, all commands will be required to restore the system.
Related » Sequence Files
Topics

Abort



Analog (Voltage) Output at BNC Connector

Introduction

The Model 6000 rear panel has four BNC Connectors, which may be configured to supply a fixed output
voltage. This section explains the setting of these outputs.

GPIB The GPIB SIGOUT command may also be used to set the BNC voltage output. Refer to Appendix B for
Equivalent additional information.
Analog The four Model 6000 BNC connectors labelled Al through A4 may be configured to supply a fixed voltage
Outputs of -10 to +10 volts, or linked to a selected system parameter (see Link). The Al output is duplicated on the
Model 6000 front panel for easy access.

Selection The following table describes the parameters of the analog output setting:
ltems

The Item... | Specifies... Allowed Values

Channel which of the four rear panel BNC connectors lto4

(Al through A4) is to be set.

Voltage the output voltage at the specified channel. -10 to +10 volts
Model 6000 Press the following keys to view the Set Voltage Output at BNC Connector screen:
Keystrokes

Control, Immediate Operations, 10: SigOut

PPMS Control
Panel

The analog outputs are set from the Analog Output panel of the PPMS Control Panel. This panel is
opened by pressing the Analog Out button of the PPMS Control Panel. The analog output values are set
from the Signal Channels portion of this panel.

Setting the Note: The minimum recommended load resistance for these channels is 10 kohms.
BNC Output
Voltage 1. Specity the Channel number to be set (Channel 1 through 4 for Connectors A1 through A4,
respectively).
2. Specify the output voltage (from -10V to +10V).
Removing a If a channel was previously “Linked” to a system parameter, the existing link will be terminated by the set
Parameter voltage command.
Link
Related » Link BNC to Parameter
Topics » Status - Other

Analog Output at BNC Connector



4

Bridge Channel Setup

Introduction

The Model 6000 Resistance Bridge offers four channels which may be configured to measure the
resistance with specific current drive and measurement parameters.

GPIB The GPIB BRIDGE command may also be used to set the resistance bridge parameters. Refer to Appendix
Equivalent B for additional information.
About the The four channel resistance bridge may be configured to perform a four-wire resistance measurement. The
Resistance bridge actually has up to eight channels available, however, channels 5-8 are reserved for internal
Bridge calibrations. The bridge offers an optional square wave excitation of approximately 7.5 Hz synchronized to
the AC line frequency (50 or 60 Hz) to reject AC line noise.
Selection The following table explains each of the entry fields for the Resistance Bridge configuration:
Items
The ltem . .. Specifies. .. Allowed Values
Excitation Current | the maximum excitation to be applied to 0.00, 0.01 to 5000.00 pA
the external device.
Power Limit the maximum power to be applied to the 0.0, 0.001 to 1000.0 pA
external device.
Calibration Mode how frequently the analog-to-digital Fast
(Measure Mode) converter will read the internal precision «Standard (default)
resistors to recalibrate its readings. *High Resolution
Mode excitation type for the resistance *AC
(Drive Mode) measurement. DC
Model 6000 Press the following keys to view the Model 6000 Setup Bridge Channel screen:
Keystrokes

Control, Immediate Operations, 06:Bridge

PPMS Control
Panel

The bridge channel 1s configured from the 4-Channel Resistance Bridge screen of the PPMS Control
Panel. This panel is opened by pressing the Resis. Bridge button of the PPMS Control Panel.

Configuring
the
Resistance
Bridge

1. Select a Resistance Bridge Channel and enter an Excitation Current and Power Limit.
2. Select the Calibration Mode and (Drive) Mode.
Note: If either the Power Limit or Excitation Current are set to zero for a channel, the channel will be
automatically turned off.

Current and
Power Limits

»  When the bridge channel is in operation, the Excitation Current will be limited by either the maximum
Excitation Current or Power Limit, whichever limits the current to a lower value.

Bridge Channel Setup
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Calibration
(Measure)
Mode

In Standard Calibration Mode the internal analog-to-digital calibration is updated approximately once
each hour to account for thermal and other long-term drifts in the bridge electronics.

In Fast Calibration Mode bridge channel readings are performed as quickly as possible and no analog-
to-digital calibration readings are performed.

Excitation
Mode

The AC excitation is a square wave excitation of approximately 7.5 Hz synchronized to the AC line
frequency (50 or 60 Hz) to reject AC line noise.

In AC mode, the excitation current is reversed between the first and second measurements, and one-half
of the difference between the two readings 1s reported.

In DC mode, two readings are made with the same polarity and then averaged.

Bridge Channel Setup
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Configure Menu (Top-Level)

Description

The Configure menu is a Model 6000 top-level menu that allows access to various Model 6000 system
configuration settings.

CONFIGURE

*1. Time & Date...
2. Serial Port. . .
3. IEEE-488 Port...
4. Level Sensor
5. Software
6. Hardware

Model 6000 Press the following key to access the Configure menu;
Keystrokes
Configure
Menu Items The following table explains each of the menu items found on the Configure screen:
Select... In Order To...
1. Time & Date set the system time and date.
2. Serial Port configure the serial port.
3. IEEE-488 Port configure the IEEE-488 port.
4. Level Sensor set the helium level sensor parameters.
5. Software set User Preferences, Error Logging, and Diagnostic Flags.
6. Hardware set the Magnet Configuration, Magnet Quench Configuration,
Position Configuration, and Pressure Sensor.
Related * Time & Date + Level Sensor
Topics » Serial Port * Software
* IEEE-488 Port * Hardware

Configure Menu (Top - Level)



Control Menu (Top-Level)

Description The Control menu is a Model 6000 top-level menu that allows access to various system control menus.

CONTROL

»1. Interactive Contral . . .
2. Sequence File Control . . .
3. Immediate Operation . . .

Model 6000 Press the following key to access the Control menu:

Keystrokes

Control
Menu Items The following table explains each of the menu items found on the Control screen:
Select... In Orderto...
1. Interactive Control perform chamber and sample motion operations.
2. Sequence File Control run and stop sequence file execution.
3. Immediate Operations immediately perform system operations.
Related » Interactive Control
Topics * Sequence File Control

» Immediate Operations

Control Menu (Top-Level)
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Data File: Overview

Introduction

This section explains how measurement data are handled by the Model 6000 and the PPMS Control Panel.

About PPMS When commanded to create a data file, PPMS data records are stored to the Model 6000 data file. This file

Data Files may then be uploaded to a host computer, or viewed directly from the Data File Listing screen on the
Model 6000.

File Size The Model 6000 data file can hold up to 2000 empty records or about 100 full records. The actual number

of records will depend upon record size. (In the future, this number may be expanded.) The data file size is
displayed on the Status - System screen of the Model 6000.

File Structure

Data File

The data file consists of records of information presented in sequential order. Each line represents a record.
The following table describes each field that will appear (from left to right) in the data file:

Field Description

Bit Flag This 1s a bit flag which reports which system
parameters are represented in the data record.

Note: For a full listing of the bit flag parameters, and
the data file structure, see Appendix C: section C.2.

Timestamp Timestamp: This is the time, in seconds, since
midnight, January 1st of this year.

Parameters This will be the first parameter selected for display.
Parameters will be displayed in the order that they are
represented on the Table in section C.2




Data File: Comment

Introduction Frequently it 1s desirable to place a string comment in the data file at a specific line. The comment may be
used to identify the sample, experiment, or experimenter.

Using the Data file comments are inserléd differently depending upon the interface option in use. The following table
Different lists where specific information about this procedure is located:
Interfaces
If You Are Using.. .. Refer To Section. .. On Page
Model 6000 Menu System Data File: Comment, Model 6000 10
PPMS Control Panel Data File: Comment, PPMS Control Panel 11
GPIB Appendix B: COMMENT B-5

Data File
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Data File: Comment, Model 6000 Instructions

Description The Model 6000 Data File Comment screen is used to insert a comment into the Model 6000 data file.
Model 6000 Press the following keys to view this screen:
Keystrokes
Control, Immediate Operations, 05:Comment
Selection
Iltems
Placing a
Comment In
the Data File
Related
Topics

Data File
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Data File: Comment, PPMS Control Panel Instructions

In This This section describes how to place a comment into the Model 6000 data file when using the PPMS Control
Section Panel.
Description The Comment DataFile command of the Sequence File Editor allows the user to enter a comment for
insertion into the data file. This panel is shown below:
emperature Set
W ait for Condition

Opening the Open the Comment panel from the Sequence File Editor screen of the PPMS Control Panel. The
Comment following instructions explain how to open this screen:
Panel

1. From the PPMS Control Panel, open the Window menu and select Editor.

2. With the Editor panel opened, sclect Comment from the command list on the right side of the

screen. Double-click the left mouse button to open the Comment panel.

Inserting a In order to place a comment in the data file, it is necessary to write a sequence file that includes the
Commentinto  Comment command. The file may contain only the Comment command to immediately place the
the Data File comment into the data file, or it may contain a series of system commands with the Comment command

placed at specific points of interest. For information about writing a sequence file, see "Sequence Files.”
The following instructions explain how to insert a comment into the data file using the PPMS Control Panel.

1. Open the Editor panel (see above).

2. Place the cursor at the line of the Sequence file where you want data to be collected.

3. Select Comment from the command list by placing the cursor on Comment and double-clicking
the left mouse button.

4. The Comment panel will now be displayed. Type in your comment using the keyboard. Note that
1t 1s not necessary to use quotation (") marks around the comment.

5. When you are done press the OK button to place the comment line into the sequence file. To leave
without making any changes, press Cancel.

Data File
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Data File: Creating a Data File

Introduction A data file 1s not autmatically generated during a measurement, instead, it is necessary to specify which
system information should be placed into the data file. This section explains this proceedure.

Using the The Measure command is used to specify which system parameters are to be placed into the data file. The
Different following table lists where specitfic information about this command is located:
Interfaces
If You Are Using ... Refer To Section... On Page
Model 6000 Menu System | Creating a Data File From the Model 6000 14
PPMS Control Panel Creating a Data File From the PPMS Control Panel 15
GPIB Appendix B: Measure, and Appendix C B-17, C-1

Data File
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Data Selection
Items

The following table describes each item that may be placed into the data file. (Specific information about

each parameter is provided under the parameter description elsewhere in this manual.)

Select ... To Insert the . .. For More
Information
Model 6000 | PPMS Control See Section ...
Screen Panel
Status General Status system status code. Appendix C, page C-7
Temp Temperature system temperature. Temperature
Field Magnetic Field magnetic field. Magnetic Field
Brg#Res Brg Ch-# resistance of the specified bridge Setup Bridge Channel
Resistance number.

Brgi#Exc Brg Ch-# excitation current at the specified Setup Bridge Channel
Excitation bridge.

Sig# Sig Ch-# Input signal input for Signal 1 or Signal Signal Inputs
Voltage 2

Digln Digital Inputs 8-bit status of selected inputs. Digital Inputs

MORE . .. To access the second set of
selection items.

Drv# ma Dr Ch-# Current current (mAmps) being delivered Set Driver Outputs
by the User Driver Output,

Channel 1.

Drvt W Dr Ch-# Power power (Watts) being delivered by Set Driver Outputs
the User Driver Output,
Channel 1.

Press Sample Pressure sample chamber pressure. Units Pressure Sensor
depend on user configuration.

Map 20-29 Map 20-29 user mapped item which is Appendix B, MADAT
mapped to positions 20-29, and TABLE Commands
respectively.

BACK . .. To return to the first display
SCreen.

Note: To place a comment in the data file, see Data File: Comment.

Data File



14

Data File:

Creating a Data File With the Model 6000

In This This section describes how to designate data items for placement into the Model 6000 data file when using
Section the Model 6000 menu system.
Description The Model 6000 Data File Measurements screen is used to select items to be inserted into the data file.
Data File Measurements x0007
4 Status Brg1Res Brg3Res Sig1
¢®Temp Brg1Exc Brg3Exc Sig2
+Field Brg2Res Brg4Res Digln
Pos Brg2Exc Brgd4Exc MORE. . .
[EXEC] to Execute  ( ) 4 -> Selected
Measurements Page 2
Drv1 ma Press Map 23 Map 27
Drvi W Map 20 Map 24 Map 28
Drv2 ma Map 21 Map 25 Map 29
Drnv2 W Map 22 Map 26 BACK. ..
[EXEC] to Execute ( ) 4 -> Selected
Model 6000 Press the following keys to view the Data File Measurements screen:
Keystrokes
CTRL |, 3,11
Control, Immediate Operations, 1 1:Measure
Inserting an The following instructions explain how to insert a system parameter into the data file.
Item into the 1. Enter the Immediate Operations screen (CTRL, 3).
Data File 2. Select the Measure item by placing the cursor (*) in front of the item "11: Measure" and pressing

Data File

the ENTER key. You can also use the number keys by entering " 11".

3. The Data File Measurements screen will now be displayed. Select parameters for insertion into
the data file by placing the cursor in front of the item and pressing ENTER. Selected items will
have a ¢ symbol next to them. (Press ENTER again to de-select an item.)

4. When you are done selecting items, press the ALT and ENTER keys to execute the command. To
leave without making any changes, press ESC.

5. Repeat the procedure for items listed on the second screen.

The selected items will be placed immediately into the data file.
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Data File: Creating a Data File With the PPMS Control Panel

In This This section describes how to designate data items for placement into the Model 6000 data file when using
Section the PPMS Control Panel.
Description The Measure panel is used to select items to be inserted into the data file. This panel is shown below:
Opening the The Measure panel is opened from the Sequence File Editor screen of the PPMS Control Panel. The
Measure following mstructions explain how to open this screen:
Panel 1. From the PPMS Control Panel, open the Window menu and select Editor.

2. With the Editor panel opened, select Measure from the command list on the right side of the

screen. Double-click the left mouse button to open the Measure panel.

Inserting an In order to create a data file, it is necessary to write a sequence file that includes the Measure command.
Item into the The file can contain only the Measure command to immediately place information into a data file, or it may
Data File

contain a series of system commands with the Measure command placed at specific points of interest. For
information about writing a sequence lile, see "Sequence Files.”

The following instructions explain how to insert a system parameter into the data file using the PPMS
Control Panel.

1. Open the Editor panel (see above).

2. Place the cursor at the line of the Sequence file where you want data to be collected.

3. Select Measure from the command list by placing the cursor on Measure and double-clicking the
left mouse button.

4. The Measure panel will now be displayed. Select parameters for insertion into the data file by
clicking the mouse with the cursor on the corresponding box. Selected items will have an x in the
selection box.

5. When you are done selecting items, press the OK button to place the command line into the
sequence file. To leave without making any changes, press Cancel.

Data File
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Data File: Erase Data File

Introduction The erase data file command is used to clear the Model 6000 data file buffer. This section explains the use
of this screen.

Description The Model 6000 Erase Data File screen 1s used to erase the data file currently in the Model 6000.

YOU ARE ABOUT TO ERASE THE DATA FILE

[ESC ] Keep File
[EXEC] Erase File

Model 6000 Press the following keys to view the Erase Data File screen:

Keystrokes
¥

File, Erase Data File

Selection The Erase Data File screen has only two selection items:
Items » Keep File, and
* Frase File.

How to Erase Erase the data file by pressing the ENTER key.

the Data File
WARNING: The data file will be erased immediately after you press ENTER.
To exit this screen without erasing the data file, press the ESC key.
Note: This command will only erase the data file on the Model 6000. Data files outside of the Model
6000 may be erased using the DOS "DEL filename" command.
Related » Data File
Topics * DataFile: View Data File

» Data File: Uploading the Data File

Data File
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Data File: Uploading the Data File

Why Upload All PPMS measurement data 1s collected and stored in the Model 6000, which has a limited data file

Data? capacity. Therefore, in order to graph or store the Model 6000 data file, the file must be uploaded to a
computer.

Uploading Data may be uploaded using GPIB commands or, more simply, using the Upload utility which is included

Options with the PPMS Control Panel.

Using the The following instructions explain how to upload a data file using the PPMS Control Panel:

Upload Utility

Open the PPMS Control Panel.

Open the File menu and select Upload. The Upload panel will be opened.

Open the File menu and select Open.

You will be prompted to select an output file. Either select an existing file, or create a new file.

The file should have a .DAT extension.

5. Ifthe file name you have entered does not exist, you will be asked if you want to create a new file.
Answer yes by pressing the Yes button.

6. Press the Upload button to begin the upload procedure. If it is necessary to stop the process, press

the Stop button.

= L) e

When Upload is completed, the data will be contained in the data file you have specified and will be ready
for viewing.

Using GPIB to
Upload

The GPIB DATA? command may be used to upload the data file one line at a time. In order to upload the
entire file, it is recommended that the DATA? command be placed inside a DO loop, which will stop when
an empty record is returned (indicating the end of the file). A full description of the DATA? and other
GPIB commands is provided in Appendix B of this manual.

Data File
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Data File: View Data File

Introduction

Data files may be viewed from the Model 6000 or after uploading. This section of the manual will explain
both viewing techniques.

Viewing the In order to view the Model 6000 data file, you may use either the Data File Listing screen or the GPIB
Model 6000 DATA? command described in Appendix B.
Data File
Model 6000 Press the following keys to view the Data File Listing screen:
Keystrokes
F

File, View Data File
Model 6000 The Model 6000 Data File Listing screen is shown below:
Data File

Listing Screen

Time 0 05 1.0

Status 62239 62239 62239
Temp 41605 4.1606 41614
Field 10550.994 10551.053 10551.968

Using the
Data File
Listing Screen

When the Data File Listing screen is opened, the data file records will be displayed with each parameter
described along the left side of the screen. Each data record is displayed so that the first record appears to
the left of the next.

Using Grapher
to View
Uploaded

Data

Data File

The uploaded data file may be viewed by using the Grapher utility of the PPMS Control Panel. The
following instructions describe this procedure:

1. If the Model 6000 data file has not already been uploaded, upload it to the host computer before
proceding (see Data File: Uploading Data).

2. Open the Grapher utility by selecting Graph from the PPMS Control PanelWindow menu.

3. Open the File menu of the Grapher panel and select Open Data File.

4. Select the data file from the Open Data File panel and press the OK button.

The Grapher panel will now display a graph of the selected data file. (The data file name will be displayed
across the top of the panel.)

5. Place the cursor on any graphed data point and double click the left mouse button to open the
Identify Data Point panel.

The data record corresponding to the selected data point will be listed with the plotted fields highlighted.

6. Use the vertical scroll bar to scroll through the data record or use the horizontal scroll bar to view
other records of the same file.
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Diagnostic Settings (Diagnostics)

Description The Model 6000 Diagnostic Settings screen is used to set the Model 6000 diagnostic and default
parameters.
Diagnostic Settings

1. System Diagnosis: *» Disable

2. Bridge Display chan : Standard

3. Factory Defaults on Pwr up: No

[EXEC] to Execute ( )

Model 6000 Press the following keys to view the Diagnostic Settings screen:
Keystrokes

Configure, Sofiware, Diagnostic Settings

Configuration
Items

The following Model 6000 configuration items may be set {rom this screen:
* System Diagnostics
* Bridge Display Channel
. Factory Defaults on Power Up

WARNING: The items in this menu are provided for diagnostic purposes only. In general, it is not
recommended that users reset these flags unless specifically directed to do so by a Quantum Design service
technician.

System
Diagnostics

The System Diagnostics feature allows the user to access system control channels (system bridge and
heater driver) and hardware normally used for temperature or other system control.

System Diagnostics may be enabled or disabled (default).

Bridge The Bridge Channel Display setting determines which bridge (System or User Bridge) will be displayed
Channel on the Status-Bridge screen.

Display

Factory When enabled (Yes), the Factory Defaults on Power Up setting will cause all configuration information,
Defaults on downloaded tables, and sequence files to be erased when the system is turned on.

Power Up

Related

Topics

Diagnostic Settings
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Driver Outputs

Introduction

The Model 6000 features two current drivers that may be set by the user. These outputs may be set from the
Model 6000 or the PPMS Control Panel. This section explains the use of this feature.

GPIB
Equivalent

The GPIB DRVOUT command may also be used to set the Current Drivers. Refer to Appendix B for
additional information.

Current Driver

The Driver Qutputs setting results in an output current across the System Bridge channels 1 and 2. Driver

Outputs channels 3 and 4 are reserved for the system chamber and neck heaters.

Entry ltems The following table describes each of the parameters that are set from the Set Driver Qutputs screen:
The Specifies . .. Allowed Values
ltem...

Channel the driver output channel; channels 3 and 4 are reserved lor2
for use by the PPMS temperature control system.
Current the maximum current that will drive this channel. 0.0 to 1000.0 mA
Power the maximum power that will be allowed across this 0.0 t0 20.0 mW
Limit channel.
Model 6000 Press the following keys to view the Model 6000 Set Driver Qutputs screen:
Keystrokes

Control, Immediate Operations, 08:DrvOut

PPMS Control
Panel

The Current Driver Outputs are set from the Analog Output panel of the PPMS Control Panel. This screen
is opened by pressing the Analog Out button on the PPMS Control Panel.

Setting Driver
Output

Driver Qutputs

The output current and maximum voltage may be set from the Model 6000 Set Driver Qutputs screen or
from the PPMS Control Panel Analog Output panel.

Specify the driver channel, current (nulliamps), and power limit (watts). If either the Current or Power
Limit are set to zero, the corresponding driver channel will be automatically turned off.
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Description

The Model 6000 Error Logging screen allows you to specify how errors are logged within the Model 6000

and PPMS systems.

Error Logging

THIS MENU IS NOT YET IMPLEMENTED

Model 6000
Keystrokes

Press the following keys to view the Error Logging screen:

CONFIG| , 5,2

Configure, Software, Error Logging

How To Use

This feature is not yet available

Notes

* The Error Logging feature is not implemented yet.

Related
Topics

Error Logging
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External Select Lines

Introduction

The External Select Lines are accessed by the Model 6000 rear panel and may be activated from the Model
6000 menu system or from the PPMS Control Panel.

GPIB The GPIB EXTSET command may also be used to set the External Select lines. Refer to Appendix B for
Equivalent additional information.
External External Select lines are accessed from the P11 External connector on the Model 6000 rear panel. These
Select Lines optically-isolated transistor switches require a nominal 10K pull-up resistor on the collector. The emitter
should be tied to ground.
Specitic pinout details are provided in Appendix A.
Selection The following table provides the rear panel pinouts for the external select lines.
Items
External Port Pin Number
(P11) Collector Emitter
Select 1 1 14
Select 2 2 15
Select 3 3 16
Model 6000 Press the following keys to view the Set External Select Lines screen:
Keystrokes
Control, Immediate Operation, ExtSet
PPMS Control  The External Select Lines are set from the Digital I/O panel of the PPMS Control Panel. This panel is
Panel opened by pressing the Digital Out button of the PPMS Control Panel.
Setting The External Select Lines are activated from the Model 6000 Set External Select Lines screen or from
External the PPMS Control Panel Digital I/o panel. The External Select Lines may be either On (asserted) or Off.

Select Lines

External Select Lines
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File Utilities (Top-Level)

Description The File Utilities screen is a Model 6000 top-level menu used to access Model 6000 data and sequence file
utilities.
FILE UTILITIES
»1. Build/Edit Sequence File . . .
2. Erase Sequence File . . .
3. View Data File. . .
4. Erase Data File . . .
Model 6000 Press the following key to display the File Utilities menu:
Keystrokes
FILE
File
Menu ltems The following table describes of the menu items found on the File Utilities screen:
Select... In orderto...
1. Build/Edit Sequence File. . . | create or edit a sequence file with the Model 6000.
2. Erase Sequence File. .. erase the present Model 6000 sequence file.
3. View Data File. . . view the present Model 6000 data file.
4. Erase Data File. . . erase the present Model 6000 data file.
Related For additional information on these selection items, refer to the following sections:
Topics . Sequence Editor « Data File Listing
. Erase Sequence File » FErase Data File

. Data Files

File Utilities (Top-Level)
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Hardware
Description The Model 6000 Hardware menu allows the user to access the configuration screens for the PPMS magnet
and the optional magnet quench, sample positioner, and external pressure sensor.
Hardware
»1. Magnet Configuration...
2. Magnet Quench Configuration...
3. Position Configuration...
4. Pressure Sensor...
Model 6000 This menu is accessed by pressing the following keys:
Keystrokes
X
Configure, Hardware
GPIB MAGCNF (magnet configure), MOVECFG (positioner configure)
Equivalent
Menu ltems The following table explains each of the menu items found on the Hardware screen:
Select... In Order To...
1. Magnet Configuration. . . set or check the system magnet parameters.
2. Magnet Reset set the maximum 1nitial field, and reset heat and cool
Configuration . . . limes.
3. Position Configuration. . . select the sample motion units, units/step, and range of
motion.
4. Pressure Sensor. . . specify an external pressure gauge.
Related » Magnet Configuration
Topics * Magnet Reset Configuration

Hardware

+ Position Configuration
* Pressure Sensor
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Description The Model 6000 Helium Level screen 1s a display-only screen used to monitor the dewar helium level and

helium flow during helium transfers or to manually insert a new helium level.

Helium Level
Present level: 60% Metering
Fill Rate : 0 % /Minute
Exitat: 19:35 [INCR/DECR]

Model 6000 Press the following keys to view the Helium Level screen:
Keystrokes

Control, Interactive Control, Fill Dewar
GPIB LEVEL?
Equivalent

Display Iltems

The following table information 1s displayed on this screen:

The Item. ..

Displays ...

Present Level

the level of the helium in the dewar as a percentage of full.

Fill Rate

the rate of helium transfer into the dewar given as percent per minute.

Exit at

the time remaining before the level sensors will turn off.

Note: This value may be changed by using the INCR or DECR keys.

Level Display

* The level meter is automatically turned on when this screen is opened. Readings will be taken
approximately every five seconds until the sensors are turned off.

* The level sensors are automatically turned off when this screen 1s exited.
* The dewar should be filled when it approaches a 60% level reading since this indicates that the helium
level is just above the superconducting magnet and the dewar is nearly empty. In general, the dewar

should not be allowed to become completely empty.

Related
Topics

» Level Sensor
+ Status - System

Helium Level
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Helium Level: Level Sensor

Description The Model 6000 Level Sensor screen is used to set the parameters of the helium level sensor.
Level Sensor
Monitor Hourly >Yes
Current Level . 30%
Preheat Time . 10 sec
(Voltage at 0% = 18.6 V)
[EXEC] to Execute

GPIB LEVCNF

Equivalent

Model 6000 Press the following keys to view this screen:

Keystrokes

[cowre] . 4

Configure, Level Sensor

Configuration
Iltems

The following table describes each of the Level Sensor configuration items:

Menu Allowed Description

Item Values

Monitor *Yes When Yes is selected, the sensor will measure the level on the hour.
Hourly *No Otherwise, the sensor will only be activated when the Helium Level

screen 1s opened.

Current numeric, Enter the current helium level. The level sensor is normally set to

Level percent of read zero when the helium level is at the top of the superconducting
full magnet in the dewar.

Preheat numeric, This is the length of time that the sensor will warm before making the

Time seconds reading.

Level Sensor
Calibration

Note: For accurate calibration, the calibration helium level should be less than about 50%. Also, due to
the small voltages associated with level readings above 90%, the Model 6000 will not accept level
sensor calibrations when the helium level is greater than 90%.

To calibrate the sensor: Enter the current helium level as percent of full. A voltage value will then be
determined which corresponds to this level. The output voltage of the level sensor is zero when the helium
level is at 100% (when the dewar is full) and the voltage increases linearly as the level drops. Therefore, the
helium level may be calibrated by specifying the voltage at any specific level.

Related
Topics

» Helium Level (Fill Dewar)

Helium Level Sensor
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Description

The Model 6000 IEEE-488 Setup screen is used to set the parameters of the I[EEE-488 port located on the

Model 6000 rear panel.

IEEE-488 SETUP

Send EOS No

EOS Value 10
Append

Address :»15

Send EOL:  Yes
OUTPUT BUFFER MODE:
Ignore REM line: Yes

[EXEC] to Execute

Model 6000 Press the following keys to view this screen:
Keystrokes
3
Configure, IEEE-488 Setup
Configuration The following IEEE-488 Port configuration items may be set from this screen:
Items = Address,
« Send EOI (End-Or-Identify),
+ Send EOS (End-Of-String),
= EOS Value, and
*  Output Buffer Mode.
Note: Users not familiar with the IEEE protocol should refer to additional documentation.
Address The Address specifies the bus address for this device. This value must be known by the control software
and may have any value from 1 to 15 (15 is the default).
Send EOI The Send EOI (End-Or-Identify) is recommended for use with the IEEE interface. The default value is
(End-Or- Yes.
Identify)
Send EOS The Send EOS (End-Of-String) is a bolean flag that sends a specified character at the end of each string
(End-Of- (see EOS Value). This may be either on (Yes) or off (No).
String)
EOS Value This 1s an ASCII value that will be appended to string values when Send EOS is selected (Yes). This may
be an ASCII character that may range from O to 255.
Output Buffer ~ The Output Buffer Mode setting determines how the buffer will handle unanswered requests. The IEEE
Mode (and Model 6000) default value for this setting is Overwrite, in which unanswered requests are overwritten
as new requests are received. The Append mode is provided as an added option for those users who may
wish to use it. The PPMS Server option will automatically reconfigure this setup when the PPMS Control
Panel Software is first opened.
Related
Topics

IEEE-488 Setup
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Immediate Operations

Description The Model 6000 Immediate Operations menu is used to directly issue a system command.

Immediate Operations

01:» Temp 06: Bridge 11: Measure
02: Field 07: DigSet 12: Link

03: Move 08: DrvOut 13: MagRst
04: Chamber 09: ExtSet

05: Comment 10: SigOut

[ ]Select

Model 6000 Press the following keys to view this menu:

Keystrokes
3

Control, Immediate Operations

GPIB TEMP BRIDGE MEASURE
Equivalent FIELD DIGSET LINK
MOVE DRVOUT MAGRST
CHAMBER  EXTSET
COMMENT  SIGOUT

Menu ltems The following table explains each of the menu items found on this screen:

Select... In Order To...

01: Temp set the system temperature.

02: Field set the magnetic field.

03: Move move the sample positioner.

04: Chamber | perform a chamber operation (vent, seal, etc.).

05: Comment | place a comment into the data file.

06: Bridge set bridge channel excitation currents, calibration modes,
modes (AC/DC), and power limits.

07: DigSet activate Model 6000 rear panel digital outputs

08: DrvOut set either of the two driver output channels.
09: ExtSet set either of the three external select lines.
10: S1gOut set the voltage output at the rear panel BNC connectors.

11: Measure place specific system status information into the data file.

12: Link link the rear panel BNC connectors to a system parameter.

13: MagRst reset the magnet to release trapped flux.

Immediate Operations
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About Selection of an item listed in the Immediate Operations menu will open a corresponding entry screen that
Immediate will allow you to specify the parameters of the command. This command will be issued immediately upon
Operations execution.
Related + Temperature (Temp) » Set Driver Outputs (DrvOut)
Topics « Magnetic Field (Field) * Set External Select Lines (ExtSet)

* Move Positioner (Move) » Set Voltage Output at BNC Connector

» Configure Sample Chamber (SigOut)

« Data File Measurement (Measure) » Put Comment in Data File (Comment)
» Link BNC to Parameter (Link) + Setup Bridge Channel (Bridge)
* Magnet Reset + Set Digital Outputs (DigOut)

Immediate Operations
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Interactive Control

Description The Model 6000 Interactive Control menu contains menu items that allow the user to perform various
chamber and positioner, as well as other operations.

Interactive Control

» 1. Seal Chamber 6. Move to Index
2.Purge & Seal 7. Move...
3.Vent & Seal 8. Shutdown Mode
4. Pump Continuous 9. Abort...
5. Vent Continuous 0. Fill Dewar...

GPIB CHAMBER, MOVE, SHUTDOWN, ABORT, LEVEL?
Equivalent

Model 6000 Press the following keys to view this screen:

Keystrokes
¥

Control, Interactive Control

Menu Items The following table explains each of the menu items found on this screen:

Select... In Order To...

1. Seal Chamber immediately seal the chamber in its present state.

2. Purge & Seal pump and backfill the sample chamber for three
cycles and then seal it closed.

3. Vent & Seal vent the sample chamber with helium and then seal
it closed.

4. Pump Continuous | pump on the sample chamber continuously until
another chamber command is given.

5. Vent Continuous allow helium from the dewar to flow into the sample
chamber until another chamber command is given.

6. Move to Index move the sample to the index position switch. The
index switch is a fixed position in the sample tube.

7. Move. . . access the Interactive Move Positioner screen to
define the sample position index.

8. Shutdown Mode activate Shutdown Mode.

9. Abort . . . access the Selective Abort Operations menu.

0. Fill Dewar. . . access the Helium Level (Fill Dewar) screen.

Interactive Control
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Chamber
Commands

The Chamber Commands (items 1 through 5) will be performed immediately after the command is
executed by selecting the menu item, either by pressing ENTER with the cursor at the item, or by keying in
the item number,

Note: It is NOT necessary to press ENTER to invoke these commands when the menu item number has
been keyed in.

Move To Index

The Move to Index command will be performed immediately after the command is executed by selecting
the menu item.

Shutdown Shutdown Mode is recommended whenever the PPMS system will be left unused for an extended period.

Mode This command places the temperature controller in standby mode: both drivers used to control the system
temperature are turned off to minimize helium flow (and hence, helium consumption) and the magnet is
placed in persistent mode.

Related * Interactive Move Positioner

Topics + Selective Abort Operations

« Helium Level

* Level Sensor
 Position Configuration
* Sequence File Control
+ Sample Chamber

Interactive Control
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Link BNC to Parameter: Overview

Introduction

The PPMS allows you to link a system parameter to one of the four Model 6000 rear panel Analog Output
(BNC) jacks (labeled A1 through A4). This section explains how to create this link.

Parameter
Link Choices

The following is a list of each of the system parameters that may be linked using the Link command:

» Temperature » Magnetic Field = Sample Position

+ Bridge Channel * Bridge Channel » Signal Input Voltage
Resistance Current » Sample Heater Power

= Sample Chamber * Driver Channel » Sample [Heater Current
Pressure Current/Power

About Linking
Parameters

The Link to Parameter results in a voltage output at the Model 6000 rear panel BNC connectors labelled
Analog Ouputs, Al through A4. This output will correspond to the linked parameter value, according to
your specification of zero- and ten-volt output values. In addition to the rear panel outputs, the front panel
BNC connector shares the Al output for operation convenience.

When a parameter is selected for the link, you are asked to specify a zero-volt value and a ten-volt value.
These values will be used to report the parameter so, in general, the zero-volt value should correspond to the
lower limit, and the ten-volt value to the higher limit, of the parameter. If Value at +10V and Value at 0V
are equal, a zero reading will result.

Example: If the System Temperature is selected for the link, enter a value of 0 (zero) for the zero volt
value, and 325 for the 10 volt value. This will ensure that the reported value will be within the
range of the output.

The Output Channel selection remains active until the channel is turned Off or until a new link is specified
for that channel.

Using the
Different
Interfaces

The Link command is used to link a system parameter to the Model 6000 rear panel BNC jacks. This
command 1s issued according to the interface option in use. The following table lists where specific
information about this procedure is located:

If You Are Using ... Refer To Section. .. On Page
Model 6000 Menu System Link BNC to Parameter: Using Model 6000 33

PPMS Control Panel Link BNC to Parameter: Using PPMS Control Panel | 35

GPIB Appendix B: LINK B-15

Link BNC to Parameter



Link BNC to Parameter: Using the Model 6000

In This This section describes how to link system parameters to the BNC connectors using the Model 6000 menu
Section system.
Description The Model 6000 Link BNC to Parameter screen is shown below:

Link BNC to Parameter

Output Channel » : 1

Link to Parameter #: --off--
Value at+10V : 105
Valueat OV : 0O

[EXEC] to Execute ( )
Model 6000 Press the following keys to view this screen:
Keystrokes
Control, Immediate Operations, 12: Link
Entry Fields The following table describes each of the entry fields of the Link BNC to Parameter screen:
The Entry Specifies. .. Allowed
Field ... Values
Output which Model 6000 rear panel BNC 1 to 4, off
Channel connector (Al through A4) will contain
this link.
Link to which parameter will be linked to the Pressure
Parameter # BNC connector . Temperature
Field
Position
Bridge#Res
Bridge#Exc
Value at +10V | the parameter output value that numeric
corresponds to a BNC output of +10V.
Value at OV the parameter output value that numeric
corresponds to a BNC output of OV.

Link BNC to Parameter
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Linking a The following instructions explain how to link a system parameter to the Model 6000 rear panel BNC
System connectors.
Parameter

1. Enter the Link BNC to Parameter screen (CTRL, 3, 12).

2. Select the Output Channel (1 through 4, corresponding to Al through A4, respectively) by placing
the cursor in front of Output Channel and using the INCR or DECR key to increment the channel
value.

3. Press the down arrow key to advance to the Link Parameter # ficld and select the parameter to link
by using the INCR or DECR key to scroll through the choices.

4. Press the down arrow key again to set the Value at +10 V field, and use the number keys to key this
value.

5. Setthe Value at 0 V field using the same procedure.

6. When you have verified that the values you have entered are correct, press the ALT and ENTER
keys to execute this link.

Note: It is necessary to execute each channel link individually. Therefore, to link several channels, you

Link BNC to Parameter

will need to repeat these steps (1 through 6) for each channel.
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Link BNC to Parameter: Using the PPMS Control Panel

In This This section describes how to link system parameters to the BNC connectors using the PPMS Control Panel.
Section
Description The Analog Output panel of the PPMS Control Panel is used to link system parameters to the BNC

connectors. This panel is shown below:

Temperature

nothing

Temperature
Magnet Field
Sample Pos

Brg Ch-1 Res

Opening the The Analog Output screen is opened by pressing the Analog Out button of the PPMS Control Panel.
Analog Output

Panel

Link BNC to Parameter
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Entry Fields Each channel is listed as a separate item. The tollowing table describes each of the entry fields of the
Analog Output panel:

Entry Specifies. .. Allowed Values

Field ...

Ch # (channel | which Model 6000 rear panel BNC ltod

number) connector (Al through A4) will contain

this link.

Link Channel which parameter will be linked to the Nothing

to: BNC connector . Temperature
Magnetic Field
Sample Position
Bridge#Res
Bridge#Exc

Signal Channel # Voltage Input
Sample Heater Power
Neck Heater Power

0 Voltsout at: | the parameter output value that numeric
corresponds to a BNC output of 0 V.

10 Volts out the parameter output value that numeric
at: corresponds to a BNC output of +10V.

The current output voltage will be displayed in the Output Volts field.

Linking a The following instructions explain how to link a system parameter to the Model 6000 rear panel BNC
System connectors.
Parameter

**% These are PPMS Control Panel Instructions®***

1. Open the Analog Outputs panel.

2. For each channel you want to link, select the Link-to parameter by pressing the down arrow button
to the right of the entry field. An unlinked channel will display the word nothing in this field.

3. Press the tab key, or use the cursor, to advance to the 0 Volts out at: field and key in (using your
computer keyboard) the zero-volts value for the selected parameter.

4. Advance to the 10 Volts out at: field and enter this value.

5. Press the Exec button at the far right of the entry line. This button will be enabled when a link to
parameter has been selected.

Once executed, the link will be immediately invoked. The output voltage will be displayed in the now-green
Output Volts field.

Link BNC to Parameter



Magnet Control: Setting the Field, Overview

Introduction

The magnetic field of the PPMS may be set directly by the user, or may be programmed as part of a
sequence file using either of the interface options.

Magnetic Field
Values

When setting the magnetic field, the value of the magnetic field is not directly measured by the system:;
the current through the magnet coil is set according to the particular magnet installed in your system. This

method of field setting does not account for remanent fields that may be present in the magnet (depending

upon the recent history of the magnet).

Magnetic Field
Parameters

The following table explains each of the magnetic field parameters you will be asked to specify:

The Item... Specifies... Allowed Values
Value the target system field. Once executed, the Depends on svstem maenet.’
system will attempt to set this field. P - =
The charging rate (oersted/second) of the DEP?ndS upon B./I e
. . maximum charging voltage,
Rate magnetic field when ramping from the .
and inductance of the system
present value to the new target value. b
magnet’.
The process by which the magnet charges to
the new field value. e Linear
Approach e No Overshoot
Note: See Magnetic Field: Approach Mode | ¢  QOscillate
for details of this parameter.
The mode in which the magnet is to be left at
the end of the charging process. ¢  Pewi
Mode )
e Drive

Note: See Magnetic Field: Mode for details
of this parameter.

T The maximum magnetic field and charging rate depend upon the magnet configuration and are displayed in the Magnet
Configuration menu of the Model 6000.

In addition to the entry fields, the magnet status code and current field value are displayed at the
bottom of the screen.

WARNING!

The potential for harming the equipment is very high when the
helium level drops low enough to expose the superconducting
magnet. An uncontrolled magnet quench can occur when the
charged superconducting magnet is not completely immersed in

liquid helium.

Link BNC to Parameter
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For More This section provides information about field approach modes, magnetic control operation modes, how to set
Information the magnetic field, and the magnet quench option. Use the following table to locate the information you
need:
For Information About . .. Refer to the Section ... On
Page
How to Set the Field Using the | Magnet Control: Setting the Field, Model 6000 39
Model 6000
How to Set the Field Using the | Magnet Control: Setting the Field, PPMS Control 40
PPMS Control Panel Panel
Magnet Approach Mode Magnet Control: Approach Mode 41
Magnet Mode Magnet Control: Mode 42
Magnet Reset Option Magnet Control: Reset 43
Magnet Status Codes Magnet Status Codes 44
GPIB Magnet Commands Appendix B: MAGCNF, MAGCNE? B-16,17

Magnet Control
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Magnet Control: Setting the Field, Model 6000

In this section  This section describes how to set the magnetic field using the Model 6000 menu system.

Description The Model 6000 Set Magnetic Field screen is used to set the magnetic field:

Set Magnetic Field
Value > : 1000 Qe

Rate ; 10 Oe/sec
Approach : Oscillate
Mode : Persist Magnet
(Status: Persist 1000)
[EXEC] to Execute ( )
Model 6000 Press the following keys to view the Model 6000 Set Magnetic Field screen:
Keystrokes
Control, Immediate Operations, 02: Field
How to Set The following instructions explain how to set the magnetic field using the Model 6000 menu system:
the Magnetic
Field 1. Enter the Set Magnetic Field screen (CTRL, 3, 02).
2. Keyinafield Value (in cersted). The allowed range will depend on the system magnet.
3. Press the down arrow key to advance to the Rate field.
4. Key in a Rate value (in oersted per second). This is the rate at which the system will change to the
new field.
5. Press the down arrow to advance to the Approach field.
6. Use the INCR or DECR key to select an approach mode.
7. Advance to the Mode field and select a magnet mode.
8.  Pressthe ALT and ENTER keys at the same time to execute this command. The magnet control

system will invoke this field change immediately.

To exit without saving any changes, press the ESC key.

Magnet Control
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Magnet Control: Setting the Field, PPMS Control Panel

In this section  This section describes how to set the magnetic field using the PPMS Control Panel.

Description The Field panel is used to set the magnetic field from the PPMS Control Panel:

’ Pemsten.t l

Opening the The Field panel is opened from the Control Panel of the PPMS Control Panel. The following instructions
Field Panel explain how to open this panel:
1. From the PPMS Control Panel, place the cursor on the Field display. The cursor will change from
an arrow to a hand.
2. Press the left mouse button once. The panel will now be opened.

Note: To open the Field panel with the cursor at a specific parameter, place the cursor on the parameter
display of the Control Panel and click the mouse.

How to Set The following instructions explain how to set the magnetic field using the PPMS Control Panel:
the Magnetic 1. Open the Field panel (see above).
Field Key in a field Value (in oersted). The allowed range will depend on the system magnet.

2.

3. Press the Tab key to advance to the Rate field.

4. Key in a Rate value (in oersted per second). This is the rate at which the system will change to the

new field.

Press the Tab key to advance to the Approach field.

6.  Press the down arrow button to display the approach modes. Select an approach mode by placing

the cursor on the mode and clicking the mouse.

Advance to the Mode ficld and select a magnet mode using the same technique as above.

8. Press the OK button to execute this command. The magnet control system will invoke this field
change immediately.

bl

o

To exit without saving any changes, press the Cancel button.

Magnet Control
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Magnet Control: Approach Mode

Description The Magnet Approach Mode determines the final approach used by the system to reach the target
magnetic field.

Magnet The PPMS Magnet Control System follows a specific algorithm to reach a set point (target) field value.

Approach When the magnet is charging to this value, the Approach Mode determines how the field is approached.

Mode Once the field is near the target value, an iterative process is used that sets the magnet current to the value
that corresponds the requested magnetic field. This current is set within the limitations of the PPMS
hardware: approximately 1 milliamp for currents above 5 amps, and about 100 microamps for currents
below 5 amps with High Resolution enabled.

Approach The following table describes each of the magnet Approach Modes used during the magnet field charging

Mode process:

Definitions

Approach 5 s
Mode Description
The field approaches the target value at the rate specified by the Rate
Linear parameter. The charging rate is fixed throughout the field change, the iterative

approach process described above is not used.

The field value is approached by discrete steps small enough to ensure that the
target value is never exceeded. The specified Rate will be used to the extent
possible when field change steps are large enough to produce the charging
voltage required to satisfy the Rate.

The target value is approached by a series of oscillations with successively
decreasing amplitude.

No Overshoot

Oscillate
Note: If magnetic hysteretic effects are important in the sample to be
measured, this mode should not be used.

Using Linear
Mode

* Since the iterative approach process is not used to reach the target value when the Linear Approach
Mode is used, the final field will not be precise as compared to other approach modes.

Using No * The No Overshoot mode should be used if magnetic hysteretic effects will degrade the experiment.
Overshoot

Mode

Using * The Oscillate approach mode is designed to minimize flux movement in the superconducting magnet
Oscillate after the final field value has been reached.

Mode * The Oscillate approach eliminates most of the magnetic relaxation effects normally found in

superconducting magnets and makes it possible to achieve a very stable magnetic field large, even after
large changes in magnetic field.

 If magnetic hysteretic effects may degrade the experiment or affect the sample, the Oscillate mode should
not be used.

Magnet Control
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Magnet Control: Mode

Description The Magnet Mode specifies the mode in which the magnet is to be left at the end of the charging process.

Magnet Mode The following table describes each of the Magnet Modes available on the PPMS:
Definitions

Magnet

Mode Description

The magnet is placed in persistent mode, with the persistent switch heater and
Persist magnet power supply turned off, placing the magnet's persistent switch in the
persistent (superconducting) state. The magnet power supply unit is turned off.

The magnet current is continuously supplied by the magnet power supply. The
Drive persistent switch remains open (switch heater on) and the current through the
superconducting magnet is provided directly by the power supply.

Persist Mode * The Persist mode will provide the most stable magnetic field available.

Drive Mode * In Drive mode, 60 Hz ripple and low frequency drifts in the magnet power supply will contribute to
fluctuations in the magnetic field.
* The Drive mode allows the magnetic field to change much more rapidly than when using Persist Mode.
Therefore, this mode is recommended for situations in which frequent and brief field changes will be
required.
* Drive mode is not recommended for samples that are field hysteretic.

Magnet Control
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Magnet Control: Magnet Reset

Description The Model 6000 Magnet Reset screen is used to quench the superconducting magnet coil. The Reset
heater is a PPMS option.
Magnet Reset
Drive to Field:>» Oe
Rate : Qelsec
[EXEC] to Execute ( )
Model 6000 Press the following keys to view this screen:
Keystrokes
Control, Immediate Operations, 13: MagRst
Entry Fields The following table describes the two entry fields of the Magnet Reset screen that specify the parameters of

the magnet quench:

The Entry Determines.. ..

Field ...

Drive to Field | the field (oersted) to which the system will drive the magnet before
initiating the reset (turning on the reset heater).
Note: The reset will begin when the field is within 10 oersted of the

Drive to Field.

Rate the rate (oersted per second) at which the system will be driven to the

Drive to Field value.

Magnet Reset

The Magnet Reset is an option which allows the user to purge the system magnet of trapped magnetic flux,
restoring it to a state similar to that achieved when the magnet is first cooled down. Although trapped flux
may be insignificant at high field values it can become more significant at low field values.

Magnet Control
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Magnet Status Codes

Description The Magnet Status Code is displayed on the Model 6000 Status - System and Set Magnetic Field
screens, and on the PPMS Control Panel. The status code indicates the present state of the magnet control
system.

Code The following table provides the meaning of each of the magnet status codes.

Definitions

Magnet Status Code
Model 6000 | PPMS Control | Meaning
Panel
Charging Charging Magnet is Charging
Charging Discharging Magnet is Discharging
Chrg Err Chrg Err Magnet Charging Error
Curr Err Curr Err Incorrect current in magnet
Failure Failure General Magnet Failure
Holding Holding Holding Magnetic Field; Driven mode
Iterate Iterate Iterating; Driven mode
Persist Persist Persistent Mode
PSU Err PSU Error Power Supply Error
SW-Cool SW-Cool Persist Switch Cooling
SW-Warm SW-Warm Persist Switch Warming
SWTC Err SWTC Err Persist Switch Error
Quench Quench Uncontrolled Magnet Quenching (Reset)
Unknown Unknown Error

About Failure Failure status will result from a hardware failure. If the Failure status persists, contact Quantum Design
Status with details of the system operation prior to the failure.

Magnet Control
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Model 6000 Front Panel

Description The Model 6000 Front Panel display and key pad may be used to control most aspects of the PPMS. The
front panel features and keys are described below.

Key Groups The Model 6000 provides a display screen, entry keys, and a BNC output jack. For the purpose of
Overview explanation, the keys are grouped according to function. The following table provides a summary of the use
of these keys:

Key Group... | Is Used To...

Menu access the top-level menus (Status, Control, Files, and Config).

Arrows move the cursor (with the arrow ) and to increase (or decrease) entry values
(INCR or DECR).

Number to enter number values for entry fields or to select numbered menu items. Also

to ABORT system operation or to place the system into LOCAL mode.

Display ltems The Model 6000 front panel, in addition to the main display screen, includes Remote and Error display
lights. These will light when the system is in Remote mode or when an error condition exists.

Magnet Control
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Model 6000 Front Panel: Using the Keys

Description

In this section, the use of the Model 6000 is explained. It is recommended that this section be read before
using the Model 6000 front panel. For additional information and a tutorial, refer to Chapter Two: An
Example Measurement.

Using the
Menu Keys

The Menu Keys are located to the left of the display screen. Press any of these keys to immediately display
the corresponding top-level menu. The top-level menu will be displayed regardless of the current display
screen. This feature allows the user to access any screen by using the same key sequence.

Example 1: In order to display the Status-Bridge screen at any time, press the STATUS key three times
from anywhere in the Model 6000 menu system.

Example 2: f you are in the third-level Setup Bridge Channel screen, and want to look at the Helium
Level screen, press the following key sequence:

To select CONTROL, 1. Interactive Control, and Fill Dewar.

Using the
Arrow Keys

The Arrow Keys are used to move the cursor around on the screen, to increase or decrease entry values, or
to toggle through entry choices (INCR or DECR keys only).

The ALT key is used to accelerate any of the other Arrow keys. Therefore, when any of the Up, Down, Left,
or Right arrows are pressed with the ALT key, the cursor will move faster or the entry value will change
faster. Similarly, if ALT and INCR are pressed together (or ALT and DECR) the entry value will change
in larger increments (increments equivalent to one eighth of the total value range).

Using Enter,
Execute, and
Escape

To the right of the arrow keys are the ESC and ENTER keys. The ENTER key also acts as the
EXECUTE key by pressing ALT and ENTER together. The following table explains the use of each of
these commands:

Use the Key... | InOrderTo...

ENTER activate an entry that does not require the Execute command. This is
primarily used for menu item selection.

EXECUTE Execute a command, configuration setting, or another entry that requires the
[EXEC] Execute command. Screens that require the Execute command will have the
line "[EXEC] to execute" along the bottom. Changes made to these screens
without execution will not be implemented.

ESC leave a screen or entry value without affecting any change.

Using the
Number Keys

To use number keys, key in a number value and press the Enter key. In addition to the ten digits, this key
pad also includes a decimal (. ) and a plus/minus ( +/- ) key.

When the decimal key is pressed with the ALT key, LOCAL mode will be activated (the system will be
taken out of Remote mode).

When the plus/minus key is pressed with the ALT key, the ABORT command is issued and all system
operations are immediately terminated.

Model 6000 Front Panel
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Description The Model 6000 Pressure Sensor screen is used to specify the sensor type and units of measurement for an
external pressure gauge.
Pressure Sensor
Sensor :* Baratron
Units Mictrons
Units/V 10.0
[EXEC] to Execute
Using a The PPMS is designed to allow the user to connect an external pressure gauge to the system. This Sensor
Pressure output may be directed to one of the Model 6000 rear panel BNC connectors by using the LINK command
Sensor (see Link BNC to Parameter).
Model 6000 Press the following keys to view the Model 6000 Pressure Sensor screen:
Keystrokes

Configure, Hardware, Pressure Sensor

Configuration
Items

The following table describes each of the items set from the Model 6000 Pressure Sensor screen.

Menu Allowed Description

Item Values

Sensor *Baratron This is the type of external pressure gauge that you have connected
*Pirani to the Model 6000 rear panel Pressure port.
*Internal

Units *Microns These are the units used to report the sensor pressure. Since the
*Pascals sensor will actually be reporting a calibrated voltage change, this
*Bars value 1s for display purposes only.
'mm Hg
*Torr

Units/V numeric This is the value of Units that corresponds to one volt of change.

About Sensor
Settings

* When using a Pirani (or any non-Baratron) sensor, the Units/V field will read Table and the user must

manually load a conversion table by using the GPIB TABLE command.
* When a Baratron sensor is sclected, the Model 6000 will automatically create a conversion table based
on the value entered in the Units/V field.

+ If Baratron is entered after a Pirani sensor has been in place, the Pirani table will be overwritten.

+ When either sensor is selected, the pressure will be displayed in the Status screen.

Related
Topics

Pressure Sensor

«  Status - Other
« Link BNC to Parameter
+ Appendix B: GPIB TABLE command
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Sample Chamber: Commands

Introduction

The sample chamber may be vented, purged, or sealed from either of the PPMS interfaces. This section
explains how to configure the sample chamber using the Model 6000 menu system and the PPMS Control

Panel.
Chamber The following table explains each of the sample chamber commands;
Commands
Chamber Menu Item
Model 6000 | PPMS Control | nOrderTo...
Panel
1. Seal Chamber | Seal immediately seal the sample chamber in its present state.
2. Purge & Seal | Purge/Seal cause the system to pump and backfill the sample chamber for
three cycles and then seal it closed.
3. Vent & Seal Vent/Seal vent the sample chamber with helium and then seal it closed.
4. Pump Evac pump on the sample chamber continuously until another
Continuous chamber command is given.
5. Vent Vent allow helium from the dewar to flow into the sample chamber
Continuous until another chamber command is given.

Caution The system temperature should always be near room temperature (275 to 300 K) before venting the sample
chamber. This will prevent condensation from forming inside the chamber. Condensation can introduce
foreign particles into the system, which will ultimately cause the impedance tube to become blocked,
resulting in temperature control failure or other problems.

About Chamber Commands are performed immediately after the command is executed by selecting the menu

Chamber item and pressing ALT and ENTER (Model 6000), or by pressing the command button (PPMS Control

Commands Panel).

More Specific information on using the chamber commands with the different interfaces is provided in the

Information following sections:

For Information About. ..

Refer to Section...

On Page

Using the Model 6000

Sample Chamber: Commands, Model 6000 49

Using the PPMS Control Panel

Sample Chamber: Commands, PPMS Control Panel 50

Using GPIB

Appendix B: CHAMBER B-4

Sample Chamber Status Codes

Sample Chamber: Status Codes 51




49

Sample Chamber: Commands, Model 6000

In This This section describes how to perform sample chamber operations using the Model 6000 Menu System.
Section
Description The Model 6000 Configure Sample Chamber screen is used to perform sample chamber operations. The

selection items on this screen are 1dentical to those on the Model 6000 Interactive Control menu and the
PPMS Control Panel.

Configure Sample Chamber
Select Configuration: 1
1. Seal Chamber
2. Purge & Seal
3. Vent & Seal
4. Pump continuous
5. Vent Continuous

[EXEC] to execute ( )
Model 6000 Access this screen by pressing the following keys:
Keystrokes

Control, Immediate Operations, 04:Chamber

Performing The following instructions explain how to perform any of the five chamber operations:
Sample
Chamber Caution: The system temperature should always be near room temperature (275 to 300 K) before venting
Operations the sample chamber.

1. Enter the Configure Sample Chamber screen (CTRL, 3, 04).

2. Key in the number of the command you want performed.

3. Press ALT and ENTER to execute the command. The chamber operation will be performed
immediately.

Sample Chamber
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Sample Chamber: Commands, PPMS Control Panel

In This This section describes how to perform sample chamber operations using the PPMS Control Panel.
Section
Description Sample Chamber operations are performed from the PPMS Control Panel, shown below:

Performing The following instructions explain how to perform any of the five chamber operations:

Sample

Chamber Caution: The system temperature should always be near room temperature (275 to 300 K) before venting
Operations the sample chamber.

1. Open the PPMS Control Panel.
2. Press the button that corresponds to the command you want performed. The chamber peration will
be performed immediately.

Sample Chamber
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Sample Chamber: Status Codes

Description The Sample Chamber Status Code indicates the present state of the sample chamber.

Display The Chamber Status Codes are displayed on the Model 6000 Status - System screen and on the PPMS
Control Panel to report the current state of the system sample chamber.

GPIB The GPIB CHAMBER? command may be used to obtain the sample chamber status.

Equivalent

Code During normal operation, the sample chamber will cycle through various states. The following table

Definitions explains each of the Chamber Status codes:

Status Code | Meaning

Failure General chamber failure

Flooding Chamber is being vented continuously
Pumping Chamber is being pumped continuously
Purged Chamber 1s purged

Purging Purging in "Evacuate & Seal" process
Sealed Chamber is sealed

Vented Chamber is vented

Venting Venting in "Vent & Seal" process

About Failure
Status

Failure status will usually result when the chamber status is in an unknown state. This status may be
resolved by sending any Chamber command (seal, purge, vent, etc.) or by Aborting the Chamber Ops.

Related
Topics

+ Status - System

* Interactive Control

* Configure Sample Chamber
» Selective Abort Operations

Sample Chamber
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Sample Motion: Overview

Introduction

The Sample Positioners are PPMS options that either rotate the sample on a vertical axis or move the
sample longitudinally within the sample space. This section explains how to configure and use the sample
positioner. (Note: this is different from the ACMS Option positioner.)

About using In order to use the positioner you will need to enter Position Configuration information into the Model 6000.
the Sample Sample positioning commands may then be issued from either the Model 6000 or from the PPMS Control
Positioner Panel.
Sample Once the positioner is installed and configured, the following parameters will be used to move the sample:
Motion
Parameters .
Select.. | To Specify... Allowed Values
Position the position to which you want the sample moved. depends on Range
set in Position
Note: The units for this field are set from the Configuration and on
Position Configuration menu. positioner type.
Mode how the sample 1s to be repositioned. * Normal
* Move to Index
Note: See below. * Define Current Position
Reduction | the rate of motion; zero is fastest, 14 1s slowest. Oto 14
Factor
Now at: the current sample position. display only
Mode The following table explains each of the three Positioner Modes:
Definitions

Sample Chamber

Mode What It Does Example

Normal | Moves the sample to the specified If the sample is currently at 10° and the
Position with respect to the present Position is set to 15°, the sample will be
(Now at:) position. moved to 25° (10 + 15).

Move to | Moves the sample to the index switch. The sample will be moved to the fixed

Index index switch position on the positioner.

Define Redefines the present location of the If the sample is presently at 5° and you

Current | sample according to your specifications. | want this position to be called 0°, set the

Position Position to zero, and the Mode to Define

Current Position.
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Index and The following table explains the Index and Limit switches of the sample positioner:
Limit
Switches . .
Switch Definition
Index The calibrated "zero" position. This is a hardware switch located on the positioner
unit. When calibrated, a rotator will have the Index at the zero degree position.
Limut The "upper limit" position. This is a defined limit that applies to non-rotational
positioner systems. On a linear positioner, for example, this switch would be 12 em
above the index.
Specific Specific information on the use of the Sample Positioner is provided in the following sections:
Information

For Information About . .. Refer to Section.. .. On Page

Configuring the Sample Positioner Sample Motion: Configuration 54

Using the Sample Positioner with Sample Motion: Model 6000 55

the Model 6000

Using the Sample Positioner with Sample Motion: PPMS Control Panel 57

the PPMS Control Panel

GPIB Appendix B: MOVE?, MOVECFG, MOVE | B-16,17
LIM?

Sample Motion
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Sample Motion: Configuration

In This This section explains how to configure the PPMS Sample Positioner option using the Model 6000 menu
Section system.
Description The Model 6000 Position Configuration screen is used to define the units and range of motion of the
sample positioner.
Position Configuration

Units : » Deg

Units/Step 1.0

Range 360.00

[EXEC] to Execute

Model 6000 Press the following keys to view the Position Configuration screen:
Keystrokes

Configure, Hardware, Position Configuration

Configuration
Items

Sample Motion

The following table describes each of the items that are set from the Position Configuration screen:

Item Allowed Values Description
Units « Degrees These are the units that will be used to report the sample
* Inches position. The appropriate selection will depend on the
« Mils configuration of the sample positioner.
* Millimeters
» Radians
* Centimeters
» User-Defined
Units/Step | numeric This value determines the unit distance (as defined above)
that the sample will be moved for each step of motion.
Range numeric This is the maximum distance over which the sample may
be moved.
Note: The Range is not the same as the Limit. The Limit
is a hardware switch, which the positioner cannot pass. The
Range is a software setting.
Enable * Yes When Yes is selected for this field, the Index switch
Index * No (default) becomes a hard limit for the positioner and the sample may
Switch not be moved beyond (below) the Index position.




55

Sample Motion: Model 6000, Move Positioner

In This Once the sample positioner has been installed and configured, the sample may be moved using the Model
Section 6000 menu system or the PPMS Control Panel. This section explains how to use the Model 6000 menu
system to control sample motion.
Description The Model 6000 Move Positioner screen is used to move the sample within the sample chamber using the
Sample Motion option.
Move Positioner
Position : »0.000 Deg
Mode : Normal
Reduction Factor: 00
(Nowat: .00 Deg)
[EXEC] to Execute ( )
Model 6000 Press the following keys to view this screen:
Keystrokes
Control, Immediate Operations, 03: Move
Moving the The use of this feature will depend upon the type of positioner in use on your system. The following
Sample instructions are based on a sample rotator:

1.

2.

Configure the rotator from the Position Configuration menu. The configuration process should be
performed each time the rotator is installed.

Enter the Move Positioner screen (CTRL, 3, 3).

Key in a value for Position. Note that the current position is displayed in the bottom Now at: field.
The allowed range for this field will depend upon that set in the Position Configuration screen.
Enter a Mode value. This value is selected by pressing the INCR or DECR keys to toggle through
each of the three modes. To move the sample to a new position, select Normal. See Sample
Motion: Mode for details about this field.

Enter a Reduction Factor value by using the number keys or the INCR/DECR keys.

Press ALT and ENTER to execute this command set. Sample motion will begin immediately.

Sample Motion
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Sample Motion: Model 6000, Interactive Move Positioner

In This This section explains the use of the Model 6000 Interactive Move Positioner screen.
Section
Description The Model 6000 Interactive Move Positioner menu is used to control the PPMS sample positioner option.
Interactive Move Positioner
Current Position:  0.000 Deg
= 0 steps
Use ALT, INCR, DECR keys
Model 6000 Press the following keys to view this screen:
Keystrokes
T P
Control, Interactive Control, 7. Move
Display Items The Interactive Move Positioner screen displays the following information:
The Item... Displays ...
Current Position (units) | the position of the sample positioner in specific units.
Steps the position of the sample positioner in steps. The number of units per
step 1s set from the Position Configuration screen.
Index/Limit when the positioner is at the Index or Limit switch by displaying the
corresponding word.
Note: Both the Index and Limit words will be displayed to indicate
an error condition, such as an improperly installed positioner.
Moving the This screen allows you to move the positioner in incremental steps, rather than by indicating a Move to
Sample value. Press the INCR or DECR key to move the positioner one step at a time. Press the ALT key and the
Positioner INCR or DECR key to move the positioner at a rate of 15 steps at a time.
Related ¢ Interactive Control /Move to Index
Topics * Move Positioner

Sample Motion

* Position Configuration
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Sample Motion: PPMS Control Panel

In This Once the sample positioner has been installed and configured, the sample may be moved using the Model
Section 6000 menu system or the PPMS Control Panel. This section explains how to use the PPMS Control Panel
to control sample motion.
Description The PPMS Control Panel Sample Motion panel is used to move the sample within the sample chamber
using the Sample Motion option.
Opening the The Sample Motion screen is opened by pressing the Sample Motion button located on the bottom right of
Sample the PPMS Control Panel.
Motion Panel
Moving the The use of this feature will depend upon the type of positioner in use on your system. The following
Sample instructions are based on a sample rotator:
1. Configure the rotator from the Model 6000 Position Configuration menu. The configuration
process should be performed each time the rotator 1s installed.
2. Open the Sample Motion panel (see above).
3. Select Move to Specified Position by placing the cursor on the selection circle and clicking the left
mouse button once. The selected circle will be filled in.
4. Place the cursor in the box to the right of the Move to Specified Position space. This box will
have the configured units displayed to the right of the entry field. (See diagram above.)
5. Select a Speed Reduction value by pressing the down arrow button next to the Speed Reduction
box.
6.  Press OK to execute this command set. Sample motion will begin immediately.
Moving the In addition to the procedure described above, the sample may be moved by using the sliding bar of the
Sample, Sample Motion panel. Simply place the cursor on the sliding bar button and press the left mouse button.
Alternate Hold the mouse button down and drag the slider to move the sample positioner. The blue lines above and
Method below the slider bar indicate the actual position of the sample and the button is placed at the target value.

The Now at: display will show where the sample is in the configured units.

Sample Motion
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Sequence Files: Overview

Introduction This section describes sequence files and their use. The first section provides an overview of sequence files,
followed by specific instructions for creating, editing, and running the sequence.

What is a A sequence file is a command file that contains one or more instructions for the system to carry out. It can
Sequence be written to incorporate PPMS options such as the AC Measurement Option as well as other external
File? devices. By using a sequence file, the PPMS will perform all instructions automatically and systematically,

according to your commands.

Why Use a Sequence files allow the user to specify explicit instructions to be performed in a set order, providing
Sequence consistent sample processing and automated operation. Once the sequence is written, the PPMS will
File? automatically process the commands, freeing the experimenter to perform other tasks.
Writing a The sequence file is written using either the Model 6000 or the PPMS Control Panel. The sequence file
Sequence commands are the same as those used for routine PPMS operation.
More For additional information on writing and using sequence files, refer to the following sections of this manual:
Information
For Information About. .. Refer to the Section... On Page
writing a sequence using the Model Sequence Files: Writing a Sequence Using the | 59
6000 Model 6000
writing a sequence using the PPMS Sequence Files: Writing a Sequence Using 60
Control Panel the PPMS Control Panel
an example of how to write a sequence | Sequence Files: Example 63
running a sequence using the Model Sequence Files: Running Sequences Using 66
6000 the Model 6000
running a sequence using the PPMS Sequence Files: Running Sequences Using 68
Control Panel the PPMS Control Panel
GPIB sequence control Appendix B: SEQCTRL

Sequence Files
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Sequence Files: Writing a Sequence Using the Model 6000

Description The Model 6000 Sequence Editor screen is used to create and edit a sequence for use with the PPMS.
Sequence Editor EOF: 01
01*» <EndFile> [ENT] Mod
[ . 1Del
[INC]Ins
[ESC] Done
Goto[ ]
Model 6000 Press the following keys to view the Sequence Editor screen:
Keystrokes
g
File Utilities, Build/Edit Sequence File
Selection The following table describes each of the selection items found on the Sequence Editor screen:
Items
Select ... In Order To...
ENTER modify an existing command line.
. (decimal) delete the selected command line.
INC (INCR) insert a command at the selected line.
ESC leave the editor screen.
Line Number go to the specified line number.
Creating a In order to create a new sequence, erase the current sequence file (see above) and press the INCR key to
New insert the first line. The command listing will be displayed, from which you may select a specific system
Sequence command and related parameters.
Editing a To change an existing sequence line, move the cursor (using the arrow keys) to the line to be edited. Press
Sequence the ENTER key to modify the command parameters.
Line To delete a sequence line, place the cursor on the selected line and press the” . “ (decimal) key.
To insert a command line, place the cursor on the line before the new command and press the INCR key.
When Insert is selected, the sequence command listing will be displayed and the new command should be
specified as usual.
Viewing A summary of specific command parameters will be displayed on each command line of the sequence file.
Command However, the Modify command can be used to view the details of the selected command line. This is done
Parameters by selecting the command line and pressing Enter. The parameters of the command will be displayed.
Press ESC to leave the screen without saving any changes.
Erasing a In order to erase the current sequence file, use the Erase Sequence File screen (FILE, 2).

Sequence File

Sequence Files
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Sequence Files: Writing a Sequence Using the PPMS Control Panel

In This This section explains how to use the Editor to create and edit a sequence for use with the PPMS.

Section

Opening the The Editor panel is opened from any of the PPMS Control Panel panels. Simply open the Window menu
Editor Panel and select Editor.

Description The Editor panel is shown below. This screen provides a display of the current sequence file (left side) and

a command listing on the right.

:{FIELD 1000.00 Oe 300.00 De/:
{SCANC 3600 3600 Number of StepsSpacing
| SCANT 50.00 1.90 12.00 2 Number of StepsS
E

Bridge Conlig
Chamber State
Comment DataFile
Digital Dutput
Driver Output
External Select
Field Set

i Measure

A Move Sample
“iMove to Index

i Remark
“Scan Time
“1Scan Fields

END Scan
{END of Sequence

utdown
Signal Output

i Synchronize

- Temperature Set

4w ait for Condition

Action Along the top of the displayed file, there are four action buttons which are used to edit the file. The
Buttons following table describes each of these buttons:

Press... In Order To...

Modify modify the highlighted command line.

Copy copy the highlighted command line.

Cut remove the highlighted command line.

Paste paste an item which was selected using copy or cut at the current line.

Sequence Files
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Creating a The following instructions explain how to create a new sequence using the PPMS Editor:
New 1. Enter the Editor screen of the PPMS Control Panel (see above).
Sequence 2. Open the File menu and select New.
3. Place the cursor on a command from the command list on the right side of the screen.
Note: For an explanation of commands, select Explain Commands at the bottom of the panel.
This will result in a display of information about the highlighted command. This feature
may be selected or deselected at any time.
4. Double-click the command to open the command information screen. This screen is used to enter
the various parameters about the selected command.
5. When you are done entering the command parameters, press the OK button to place the command
in the sequence, or press Cancel to continue without saving this command.
6. Select the next command and repeat this process until you have entered all of your commands.
Using Cut, When editing or creating a sequence file, it is convenient to be able to move or copy one or more lines to a
Copy, and different part of the file. The Copy, Cut, and Paste buttons are used to do this. The following table
Paste explains the use of these buttons:
Action Button How to Use It
Copy 1. Highlight the line to be copied and press the copy button.
2. Move the cursor to the line where you want the copied line to appear.
3. Press Paste and the copied line will be inserted above the line you have
selected.
Cut (or move) 1. Highlight the line you want to cut and press the Cut button.
2. The highlighted line will be removed.
3. To place the cut line in a new position, move the cursor to the new position
and press the Paste button. The cut line will be inserted above the line you
have selected.
Paste The Paste button is used only with the Cut and Copy buttons as described
above. Paste will always insert the pasted line above the current line.

Note: To select multiple, sequential lines for Cut or Copy, press the Shift key while holding down the left
mouse button. This will allow you to select several lines at a time. To deselect these lines, click on
any line without holding down the shift key.

Editing a To change an existing sequence line, move the cursor (using the arrow keys) to the line to be edited. Press
Sequence the Modify button to display the command parameters.
Line

To delete a sequence line, place the cursor on the selected line and press the Cut button.

To insert a command line, place the cursor on the line after the new command and select the command from
the command listing.

Sequence Files
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Viewing A summary of specific command parameters will be displayed on each command line of the sequence file.
Command FFor additional information, the Modify command can be used to view the details of the selected command
Parameters line. This is done by highlighting the command line and pressing Enter. The parameters of the command

will be displayed. Press ESC to exit the screen without making any changes.

Saving a To save the sequence file, select Save or Save As from the File menu of the Sequence File Editor panel.
Sequence File  The file name may be up to eight characters and will have the suffix “.SEQ”.

Erasing a The sequence file is stored just like any other file on the host computer. To erase a file use the DOS “DEL”
Sequence File  command.

Sequence Files
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Sequence Editor: Example

Description This example demonstrates how to write a sequence file. For general information about writing sequence
files, refer to the previous section.

Erasing a If you are using the Model 6000 to write a new sequence file, it may be necessary to delete or clear an
Sequence File  existing file. This is done by the following procedure:

Step | Command Key Sequence
1 Enter the Erase Sequence File screen. , 2
2 Press Execute to erase the file. ALT + ENTER

Writing a New  The following steps will demonstrate how a simple sequence file is written. Commands are provided for the
Sequence File  Model 6000 menu system.

Step Procedure Model 6000 Keystrokes
1 Enter the Sequence Editor screen. FILE |, ]
2 Press Insert to add a line to the file. (insert)
3 Select Temp to set the system temperature.
Set the following temperature parameters: 250, , ¥
« Temp: 250K
4 + Rate: 10 K/min 10, A 4
* Approach: Fast Settle
[ INncR ] , [ INCR ]
5 Execute the temperature command toreturnto | [ ALT |+ [ENTER]
the editor screen.
6 Press Insert to add another line to the file
7 Select Field to set the magnetic field.
Set the following magnetic field parameters: 2000, .Y
= Field: 2000 Oe
8 + Rate: 10 Oe/min 10, B 4
* Approach: No Overshoot
| INcR |, [ INCR |
9 Execute the field command to return to the | ALT |+ [ENTER]
editor screen.
10 Exit the editor screen. ESC

Sequence Files
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Editing an The following instructions demonstrate how to edit an existing sequence. This example uses the file that
Existing was written in the previous example.
Sequence File

Step | Command Key Sequence

1 Enter the Sequence Editor screen. 1

Move the cursor to line 2. This should be the vV.v

4 line having the FIELD command.
3 | Press the ENTER key to Modify the line.
4 Change the Approach Mode to Oscillate v.v,
[ INCR |, [ INCR ]
5 Execute the Field command to return to the [ ALT |+ [ENTER]
editor screen.
6 Move the cursor up to line 1. This should be A

the line with the TEMP command.

7 Press Insert to add a new line to the file after
the TEMP command.

Select the command WaitFor and press ,
ENTER.

Select Temperature from the WaitFor screen.
This will cause the system to wait until the
temperature is stable before continuing to the
next command.

10 | Press Execute to return to the editor screen. [ ALT |+ [ENTER]

Sequence Files
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Sequence The following table lists the commands that may be placed into a sequence file. Some commands are
Commands straight-forward and are discussed more fully in other sections of this manual (e.g., Temp, Field, etc.),
however, the following commands are only used within sequences:
Command | Purpose
WaitFor Causes the system to wait until the specified control system (temperature, field, etc.)
is stable before continuing to the next command line.
Scan Scan commands work similarly to programming "Do" loops. The command will
allow you to designate a starting and ending value, as well as step increments.
Additional commands may also be placed inside the Scan loop by using the Insert
command. There are four Scan commands on the PPMS:
* ScanC: Chronological (time) scan
* ScanH: Magnetic Field scan
* ScanP: Pressure scan
* ScanT: Temperature scan
Beep This command will cause the system to sound a tone (at your specified frequency
and duration) when the command line is executed.
Advise The Advise command is used to alert the system (or operator) when a specific line
of the sequence has been reached. This command may also used (with the ACDC-
Mag software) to invoke ACMS measurements.
Sync This command is used to synchronize external hardware to the Model 6000.
Related + File Utilities
Topics * Erase Sequence File

* Sequence Control
Sequence Editor: Example

Sequence Files
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Sequence Files: Running a Sequence Using the Model 6000

Description The Model 6000 Run Sequence Segment screen is used to run a portion of the system Sequence File.
Paused Sequence Control Now@: 1
»1. Run All 01=2Temp 125.0 20.0
2. Subset... 02 <EndFile>
3. Cont
4. Pause
5. ABORT...
Model 6000 Press the following keys to view the Sequence Control screen:
Keystrokes
-
Control, Sequence File Control
Menu Items The following table describes the menu items found on the Sequence Control screen:

Select... |InOrderTo...

1. Run All run all lines of the sequence file.

2. Subset. .. | open the Run Sequence Segment screen to run selected lines of the sequence.

3. Cont. resume sequence execution following a Pause command.

(continue)

4. Pause pause sequence execution.

5. ABORT halt all sequence operation. Note that continue will not resume execution
following an ABORT command.

Display ltems

The Sequence Control screen provides the following display items:

The ltem... | Displays...

Now @: 1 the command line that is being executed. Line I will be displayed by default.

Main Display the current sequence file. As the file is executed, the display will scroll through
Area the file.

Running a
Sequence

Sequence Files

In order to run the entire sequence, select Run All from the menu on this screen and sequence execution
will begin immediately.

If you want to run only a portion of the file, select Subset... to open the Run Sequence Segment screen.
The use of this screen is described below.
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Running Part The following instructions explain how to run selected, sequential lines of the sequence file:
of a Sequence 1. Open the Sequence Control screen (CTRL, 2).
2. Select the menu item 2. Subset. . . to open the Run Sequence Segment screen. The sequence file
will be displayed in the main area of the screen.
3. Enter a Start at: line number by either keying in the line number or by pressing the INCR or
DECR key to scroll through the file lines. This is the first line that will be executed. When this
value is entered, the corresponding line will be displayed.
4. Using the same technique as in step three, enter an End at: line number. This is the last line that
will be executed.

Note: Scan commands may not be partially selected for a run. The Start at: and End at: line numbers
must fully include any scan command.

Note: The system will not allow you to enter an ending line number that occurs before the starting line
number. If a starting line number is entered that is greater than the ending line number, the system

will automatically change the ending line number to the same value as the starting line number.

5. Verify that you have entered the correct starting and ending line numbers and press ALT and
ENTER to execute the sequence file run. Sequence execution will begin immediately.

Sequence Files
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Sequence Files: Running a Sequence Using the PPMS Control Panel

Description The Run Sequences panel of the PPMS Control Panel is used to execute and monitor sequence file
activities.

Opening the The Run Sequences panel may be opened from any of the PPMS Control Panel panels by selecting Run
Run from the Window menu.

Sequences
Panel
Entry Items The following table describes the entry items found on the Run Sequence panel:
The ltem ... | Specifies...
Run From Line | the starting line number for the sequence run. This is the first line that will be
executed.
through the ending line number. The sequence will stop running after this line is
completed.

Sequence Files
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Action
Buttons

The following table describes the four action buttons located along the bottom of the Run Sequence panel:

Press... In Order To...

Run

run the sequence file.

Pause pause sequence execution after the current line is completed. Execution can be

resumed using the Continue command.

Continue resume sequence execution following a Pause command.

Abort stop sequence execution entirely.

Display Iltems

The Run Sequence panel displays the following items:

The ltem... Displays. ..
Active Sequence the name of the current sequence file.
Current Line the current sequence file command line.

Current Command | the current line number under execution.

Total Lines in File | the total number of lines in the sequence file.

How to Run a
Sequence

Although you may create a sequence file from either the Model 6000 menu system or the PPMS Control
Panel, the sequence file must be loaded onto the Model 6000 in order to run. The following instructions
explain how to download a sequence file to the Model 6000 using the PPMS Control Panel. If your
sequence was written from the Model 6000, you may skip steps 2 through 4.

1.
2.
3

6.

Open the Run Sequences panel by selecting Run from the Window menu.

Open the File menu of the Run Sequences panel.

Select Download Sequence File and Overwrite. If you want the selected file to be appended to
the current Model 6000 sequence file, select Download Sequence File and Append.

An open file panel will open. Select the sequence file to download and press OK. A display panel
will open to indicate the status of the download as the file is downloaded. When this panel is closed
the sequence file name will be displayed in the field Active Sequence and you may proceed to the
next step.

If you want to run a portion of the file, key in the starting and ending lines in the Run From Line
and Through entry fields.

Press the Run button to begin sequence execution.

]

At any time during the sequence run, you may press the Pause button to halt the sequence execution. The
current sequence line will be completed and the system will pause execution. Press the Continue button to
resume execution.

The Abort button should only be used to completely stop execution of the file. The Continue button will
not resume execution following the Abort command.

Sequence Files
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Description The Model 6000 Serial Port Setup screen is used to set the parameters of the RS-232 serial port located on
the Model 6000 rear panel.
Serial Port Setup
Baud Rate :»300 Mode: 8,N,1
Handshake :
SRQ Char :
Termination String : LF/CR
[EXEC] to Execute ( )
GPIB SPTS (Termination String)
Equivalent SPMD (Mode)
Model 6000 Press the following keys to view this screen:
Keystrokes

[cors] 2

Configure, Serial Port Setup

Configuration
Items

The following table describes each of the RS-232 port configuration items that may be set from this screen:

Parameter Allowed Values! Specifies ...
Baud Rate up to 38.4 Kbps rate of information flow in bits per second.
Handshake None (0) Flow Control mode.
XONXOFF (1)
RTS (2)
Both (3)
SRQ ASCII O to 255 service request character. When a bad command is
Character * entered, this character will be returned.
Termination | NONE (0) the termination string value.
String CR/LF (1)
LF/CR (2)
CR  (3)
LF (€))
FF (®)]
Mode 8N,1 (0) port mode.
8,0,1 (1) bit size (8), parity (None, Odd, Even), com# (1 or 2).
8.E,1 (2)
8,N,2 (3)

1 Values in parenthesis indicate the GPIB bit representation for each parameter.

i A zero-valued SRQ Character will turn off the service request. Also, Microsoft Windows’ Terminal

mode does not support the SRQ command.

Serial Port Setup
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Set Digital Outputs (DigSet)

Description The Model 6000 Set Digital Outputs screen is used to set the Model 6000 rear panel digital outputs to
control external equipment.

Set Digital Outputs

Aux. Drive #1 : » Off
Aux. Drive #2 . Off
Aux. Drive #3 : Off
Actuator Drive : Off

[EXEC] to Execute ( )
GPIB DIGSET
Equivalent
Model 6000 Press the following keys to view this screen:
Keystrokes

Control, Immediate Operations, 07:DigSet

Selection The Set Digital Outputs screen allows you to specify a drive line for activation. The following table
Items provides the corresponding rear panel pinouts for the Digital Output lines:

Digital Output Rear Panel Port | Pin Number

Drive Return

Auxiliary Drive #1 | Auxiliary (P8) 1 14

Auxiliary Drive #2 | Auxiliary (P8) 2 15

Auxiliary Drive #3 | Auxiliary (P8) 3 16

Actuator Drive Motor (P10) 3 8
How to Set These digital output lines may be set to control external 24 volt DC relays, valves and other devices. Press

Digital Output  the INCR or DECR key to turn the selected output ON to activate the line, or OFF to turn it off.
Lines

Related * Appendix B: DIGSET
Topics

Set Digital Outputs



Software (Model 6000 Software Menu)

Description

The Model 6000 Software menu allows the user to configuration specific features of the Model 6000
firmware.

Software

»1. User Preferences...
2. Error Logging...
3. Diagnostics...
4. Data Display...

Model 6000 This menu is accessed by pressing the following keys:
Keystrokes
s
Configure, Software
Menu Items The following table explains each of the selection items found on the Software menu:
Select ... In Order To...
1. User Preferences | set the system sound settings.
2. Error Logging specify where and how error logging is performed.
3. Diagnostics enable system diagnostics, bridge channel display, and factory defaults on
power up.
4. Data Display specify data file display parameters used in the Data File Listing screen.
Related * User Preferences
Topics * Error Logging
+ Diagnostic Setlings
* Data File Listing

Software
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Status - Bridge
Description The Model 6000 Status - Bridge screen provides a display of bridge channels 1 through 4.
STATUS - BRIDGE System external
Chan 1:  --—invalid-- + 0.000 pA
Chan 2: + 0.000 pA
Chan 3: + 0.000 pA
Chan 4: + 0.000 pA
GPIB BRIDGE?
Equivalent
Model 6000 Press the following keys to view the Status - Bridge screen:
Keystrokes

[status | ,|sTatUs| | [sTATUS |

Display ltems

The Status - Bridge screen provides a display of the status of each of the four bridge channels. The
following table describes this display:

Item... | Is Displayed... | And Reports...
to the right of the the current status of the corresponding channel.
Channel channel number
Status (Chan 1:). Note: An "invalid" display indicates that the specified excitation
current is not adequate to produce a reading.
+ (Mode | to the right of the that the channel is in AC mode. Otherwise, this symbol will not
Indicator) | channel status. appear.
o at the left end of the actual current through the channel. This value is reported in
Excitation .
the channel microamps (HA).
Current ; ;
display line.
Bridge at the top right of | which bridge is being displayed. This value may be changed
Display the display screen. | from the Diagnostic Settings screen (CONFIG, 5, 3).
Indicator
Note: The values shown on this screen are set from the Setup Bridge Channel screen.

Related
Topics

Status - Bridge

* Setup Bridge Channel
+ Set Digital Outputs
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Description

The Model 6000 Status - Other screen provides a status display of the following systems:
* Driver Channel Current
+ Analog Output Signal Voltage
= Digital Output Status

STATUS - OTHER

-1- -2- -3- -4-
Drivers: 0.0 0.0 0.0 0.0 mA
Signals: 0.00 0.00 0.00 0.00 Vv
Digital: LM NX

GPIB DRVOUT?, SIGOUT?

Equivalent

Model 6000 Press the following keys to view the Status - Other screen:
Keystrokes

[sTatus| | [sTaTus|

Display Iltems

The Status - Other screen provides a display of the status of the four Driver and Signal Outputs, and
Digital Output status. The following table describes this display:

The Item . . . Displays . . .

Drivers: the current through each of the four driver channels (milliamps).

Signals: the voltage output for each of the four rear panel BNC connectors (A1 through A4).

Digital: two-letter codes that describe the state of the sample positioner, drive and select lines,
and the motor actuator.

Status - Other
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Digital Display  The following table explains the codes displayed to the right of the Digital: field (the code is displayed to
Codes indicate that the item is asserted):

Code | Meaning Connector Port
HL Hold External Port (P11) Hold line (pin 9) is asserted
UR User External Port (P11) User line (pin 5) is asserted
Al AuxlInl Auxiliary Port (P8) Drive Line #1 is asserted
A2 AuxIn2 Auxiliary Port (P8) Drive Line #2 is asserted
LM | Limt The sample positioner is at the Limit switch
NX | Index The sample positioner is at the Index position
S1 Select 1 External Port (P11) Select Line 1 is asserted
S2 Select 2 External Port (P11) Select Line 2 is asserted
S3 Select 3 External Port (P11) Select Line 3 is asserted
AC Actuator Drive Motor Port (P10) Actuator Drive Line is asserted
Related » Appendix A: Model 6000 Rear Panel Pinouts
Topics » Sample Positioner

= Set Driver Outputs (DrvOut)
= Set Voltage Output at BNC Connector (SigOut)

Status - Other
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Description The Model 6000 Status -System screen provides a display of general system status information as well as
the ability to quickly maneuver to system entry screens.

GPIB TEMP?, FIELD?, MOVE?, CHAMBER?, SEQSTAT?, DATA?, LEVEL?

Equivalent

Model 6000 Press the following key to view the Status - System screen:

Keystrokes

Display Items

The following table describes each of the items displayed on the Status - System screen:

The ltem. .. Displays the current. ..

Temp system temperature in kelvin. To the right of this value is the target
temperature, in brackets [ ], followed by the temperature control status.

Field magnetic field in oersted. To the right of this value is the target field value, in
brackets [ |, followed by the field control status.

Position sample positioner position.

Chamber sample chamber status,

Sequence sequence file status. When a sequence is running, the sequence line currently
under execution will be displayed here.

Data file data file size as percent-of-full. To the right of this value is the number of lines
in the data file, in brackets [ ].

Level helium level in the dewar as percent-of-full.

Fast Keys The Status-System screen has a feature that allows quick access to different entry screens, that bypasses the
menu system. This screen includes a cursor that may be moved from field to field. Place the cursor on a
field and press the ENTER key to open the entry screen that corresponds to that field.

Related + Set System Temperature * Interactive Control

Topics * Set Magnetic Field * Build/Edit Sequence File
» Temperature Status Codes » Helium Level
* Magnet Status Codes * Move Positioner
* Chamber Status Codes * Sequence Control

Status - System



78

Temperature: Setting the Temperature, Overview

Introduction

The PPMS system temperature may be set directly by the user or temperature commands may be
programmed as part of a sequence file using either of the interface options.

Temperature The PPMS temperature is reported continuously on the Status - System screen of the Model 6000 and on
Reporting the PPMS Control Panel. The target and actual temperatures are reported along with the status code which
reports on the current state of the temperature control system.
Temperature The following table explains each of the parameters used to set the system temperature:
Parameters
The Specifies. . . Allowed Values
Item...
Temperature | the system target temperature. Once executed, the 1.7 to 325 kelvin
system will attempt to reach this temperature.
Rate how quickly the system will approach the target 0 to 10 kelvin per
temperature. minute
Approach the final approach used to reach the target temperature. *No Overshoot
When appropriate Approach will override the Rate Fast Settle
setting.
Note: see Temperature: Approach Mode for a full
explanation of these modes.
For More This section of the manual provides information about temperature approach modes, how to set the system
Information temperature, and temperature status codes. Use the following table to locate the information you need:

Temperature

For Information About. . . Refer to the Section... On Page
how to set the temperature using Temperature: Setting the Temperature Using the 79

the Model 6000 Model 6000

how to set the temperature using Temperature: Setting the Temperature Using the | 80

the PPMS Control Panel PPMS Control Panel

temperature approach modes Temperature: Approach Modes 81
temperature status codes Temperature: Status Codes 82

GPIB temperature comands Appendix B: TEMP B-24,25
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Temperature: Setting Temperature Using the Model 6000

In This This section describes how to set the system temperature using the Model 6000 menu system
Section
Description The Model 6000 Set System Temperature screen, shown below, is used to set the system temperature.
Set System Temperature
Temperature: » 270.0 K
Rate © 101 Kim
Approach : No overshoot
(Now at: 270.0 STABLE)
[EXEC] to Execute ( )
Model 6000 Press the following keys to view this screen:
Keystrokes
Control, Immediate Operations, 01: Temp
Setting the The following instructions describe how to set the temperature using the Model 6000 menus system:
System
Temperature Enter the Set System Temperature screen (CTRL, 3, 01).

Key in a value for the Temperature in kelvin.

Press the down arrow key to advance to the Rate field.

Key in a value for the Rate in kelvin per minute.

Press the down arrow again to advance to the Approach Mode field.

Use the INCR or DECR key to select an Approach Mode.

Press the ALT and ENTER keys to execute this command. The temperature control system will
invoke this command immediately.

e A R

To exit without saving any changes press the ESC key.
Note: The value you enter in the Temperature ficld is the rarger or sefpoint temperature. This is the

temperature that the system will attempt to reach and maintain until 2 new temperature command is
issued.

Temperature
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Temperature: Setting Temperature Using the PPMS Control Panel

In This This section describes how to set the system temperature using the PPMS Control Panel.
Section
Description The Temperature panel, shown below, is used to set the system temperature.
Opening the The Temperature panel is opened from the Control Panel of the PPMS Control Panel. The following
Temperature nstructions explain how to open this panel:
Panel 1. From the PPMS Centrol Panel Control Panel, place the cursor on the Temperature display. The
cursor will change from an arrow to a hand.
2. Press the left mouse button once. The panel will now be opened.
Note: To open the Temperature panel with the cursor at a specific parameter, place the cursor on the
parameter display of the Control Panel and click the mouse.
Setting the The following instructions describe how to set the temperature using the PPMS Control Panel:
System
Temperature Open the Temperature panel (see above).

Temperature

Key in a value for the Temperature in kelvin.

Press the TAB key to advance to the Rate field.

Key in a value for the Rate in kelvin per minute.

Press the TAB key again to advance to the Approach Mode field.

Press the down arrow button to display the Approach Modes. Select an Approach Mode by placing
the cursor on the mode and clicking the mouse.

7. Press the OK button to exccute this command. The temperature control system will invoke this
command immediately.

OF LA L B e

To exit without saving any changes press the Cancel button.

Note: The value you enter in the Temperature field is the target or setpoint temperature. This is the
temperature that the system will attempt to reach and maintain until a new temperature command is
issued.
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Temperature: Approach Mode

Description The Temperature Approach Mode determines the final approach used by the system to reach the target
temperature.
Temperature The following table describes the two Approach Modes used to reach the target temperature:
Approach
Mode s
Definitions Approach Description
Mode'

The new temperature will be achieved with minimal overshoot of the target

No Overshoot
temperature.

The new temperature will be approached by slightly overshooting the target

Fast Settle 5 \ ;
temperature to minimize the time required to settle.

T When appropriate, the Approach Mode will override the Rate setting.

Using No * The No Overshoot mode will normally require longer settling times before reaching the target
Overshoot temperature.
Mode * No Overshoot mode attempts to minimize any overshoot as the temperature settles, however, it is not

guaranteed that there will be absolutely no overshoot of the final temperature.

Using Fast * In Fast Settle mode, the target temperature will typically be reached more quickly than in the No
Settle Mode Overshoot mode.
» Fast Settle mode is not recommended for use with samples that are temperature hysteretic.

Temperature
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Temperature: Status Codes

Description

control system.

The Temperature Status Code is displayed on the Model 6000 Status - System and Set System
Temperature screens, and on the PPMS Control Panel to report the present status of the temperature

Code
Definitions

During normal operation, the temperature control system will cycle through various states. The following
table provides the meaning for each of the temperature status codes that are displayed through these states:

Status Code

Meaning

Fault

General Temperature System Failure

Chasing

System 1s chasing the target temperature

Diag

System 1s in diagnostic mode

Impedfail

Impedance failure

Near

Near target temperature

Potops

Filling or emptying pot

Stable

Temperature is stable at set point

Standby

System is in standby mode

Tracking

Tracking target temperature

Unknown

Unknown status, contact Quantum Design

About Broken

Status sensor malfunction.

Temperature

A Fault status display will usually occur when the flow rate table is not properly calibrated or if there is a
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Description The Model 6000 Time & Date screen is used to set the Model 6000 time and date.
Time & Date
HH:MM:SS »12: 34: [56]
MM-DD-YY 02-09-94
( )
GPIB TIME
Equivalent
Model 6000 Press the following keys to view this screen:
Keystrokes
y
Configure, Time & Date

Setting the 1. Enter the time in hour:minutes:seconds format. The hour is set in military time (for example, 3:00 pm is
System Date entered as 15:00). The seconds field resets to zero when the new minute value is entered.
and Time

2. The date 1s set in Day-Month-Year format. Each field requires two digits, thus, February 9, 1994 would

be entered as 02-09-94.

3. Itis not necessary to press [EXEC] to save changes to this screen. The system time is updated when the

ENTER key is pressed.

To exit without making any changes, press the ESC key.

Time & Date
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User Preferences

Description The Model 6000 User Preferences screen is used to specify sound options on the Model 6000.

User Preferences

Enable Sounds:* All On
Display Input Signals: None

[EXEC] to Execute

Model 6000 Press the following keys to view this screen:

Keystrokes

Configure, Software, User Preferences

Configuration The User Preferences screen allows the user to enable different levels of sound options for the Model 6000.
ltems

About Enable The Model 6000 will sound when error conditions exist, during the course of a sequence file run, and when
Sounds an invalid key is pressed. Press the INCR or DECR key to select from the three sound options. These
options are explained in the following table:

Select... | To Enable...

All On all system sounds.

Limited all system sounds with no sounds repeated; error sounds, which are normally
repeated unti] the condition is resolved, will only sound one time.

Keys Only | key pad sounds only. All error and batch file sounds will be blocked.

None no sounds.

Note: Sounds are distinguished by tone and tone combinations rather than by cause. Therefore, when
Limited is selected, the system will not repeat the same sound even when a newer or different error
condition exists.

To exit without making any changes, press the ESC key.

User Preferences
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